
About Colour Modes
The video cards fitted in almost all Windows-capable computers provide a range of modes in which to 
present graphics. These basically set the maximum number of colours available which effects the quality 
of the images which can be displayed, at the expense of speed and the size of the images created. 

Illuminatus will allow you to create a multimedia publication in most of these graphics modes and although
some can be created no matter what graphics mode your computer is running in we recommend that you 
work in the same mode as you intend to publish in to ensure that Illuminatus Preview gives you a correct 
indication of what your publication will look like. If not Preview can sometimes be better and sometimes 
worse than the actual result you will get.

Using 256 or higher colours in your publication is always preferable and for scanned pictures, digitised 
video or sophisticated colours it is essential. In 256 colours your graphics will be much closer to 
photographic quality than in sixteen colours. 

Illuminatus features a special function which recognises when your user is trying to view a 256-colour 
publication on a 16 colour system and automatically optimises the colours for best effect. However, this 
can effect the speed of the publication noticeably.

The other difficulty is that 256 colour bitmap graphics can be very big and makes it unsuitable for even 
reasonably-sized products which are to be distributed on floppy disk.
Stylish effects can still be achieved using mono or sixteen colour graphics, particularly by using bold icon 
or symbol type images.

What Colour Mode Should I Choose?
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About Master Pages
Illuminatus allows you to save any page to disk as a master page. All the elements and contents of your 
page are saved with it. See Save As Master Page

The idea of Master Pages is to allow you to lay out elements which you want to use across all or most of 
the pages in your publication. A typical use for a Master Page would be to hold a background design for 
the whole publication and a company logo or the motto for the presentation which you want to appear on 
all the pages. This is very useful for giving the publication a consistent appearance.

If you need a similar page for most of your publication but also require some page designs for which the 
relevant Master Page is not appropriate these can be inserted and edited individually as required.

Once included in your publication the Master Page can be edited to suit particular page requirements.

Master Pages are also useful to establish consistent colour schemes across a series of pages. Instead of 
colouring the same elements repeatedly across a series of pages colour one, then save it as a Master 
Page. Then insert it again as many time as you require. Even if subsequent pages have some differences
it can be quicker and easier to edit a Master Page than to start from a blank page or template.

You can use Copy and Paste to reuse pages in a similar fashion while you remain in the Illuminatus editor
although, obviously, these pages are not available to be reused in subsequent publications.

Related Topics
About Templates
Save Page As



About Templates
Page Templates
Page Templates are the bare layouts for pages which are the fundamental building blocks of a multimedia
publication. Each Page Template consists of a design of frames (to contain the graphics and text of the 
publication) and buttons (to control the actions of the publication).

Template Styles
The Page Templates supplied with Illuminatus are divided into various sets. These sets are intended to 
provide a range of similar style templates allowing you to build a consistent-looking publication easily. 
Many have also been given titles to indicate possible uses.

User Templates
You can save templates you have edited or created from scratch using the Save Page as Template from 
the File menu. If you want to be able to show just these templates in the open template dialog box you 
should give the template a filename with "USR" as the first three letters. This enables the program to 
display it when you select User Templates from the List Files of Type drop down list.

Publication Templates
Publication Templates are simply collections of page templates allowing you to save the basic design and 
layout of whole publications ready for regular use. They are ideal for users who regularly publish 
programs or publications of a similar design - a regular newsletter, a monthly sales report or similar.

In the publication templates supplied with the program only one of each style of template is included in 
each template. Each page type can then have the common elements and properties defined before 
saving it as a master page and inserting it again or repeatedly cutting and pasting to build the number of 
pages required.



Activate When Mouse Over
This options allows you set actions programmed on buttons to happen when the cursor moves over the 
button rather than waiting for the user to actually press the button. 

This can be useful, for example, for popping up a frame with details of what is beneath the cursor.



Add
 select Add... from the Edit menu in Page View. 

This command allows you to draw your own frames and buttons on the page. You can either start with a 
blank page by using Insert Blank Page from the Publication menu in Publication View or you can add 
frames and buttons to an existing page template.

If you want to use the template you have created in future publications you can save it to disk using the 
Save Page As Template option in Page View.

Add...Frame
Add...Button



Add...Button
 select Add...Button from the Edit menu in Page View

This option allows you to draw a button anywhere on your page. You can start with a blank page or an 
existing page or page template. 

Once you have selected this option the cursor will change to the Button Drawing Cursor. You should then 
click on your page at the point where you want the top left corner of your button to be and drag down and 
to the right until the button is the right size and shape. Note that the size and shape of a selected button is
displayed in the status bar at the bottom of your Illuminatus window.

Tip: The crosshairs on the Button Drawing Cursor can be useful for lining things up when drawing objects
close to others.

You can resize and reshape the button at any time by dragging any of the eight editing handles which 
appear around it when it is selected. You can also edit the size and position very precisely by editing the 
numbers for Top, Left, Width and Height on the Summary of the Button Options dialog.

Illuminatus currently allows a maximum of 25 buttons on any one page.

Add...Frame



Add...Frame
 select Add...Frame from the Edit menu in Page View

This option allows you to draw a frame anywhere on your page. You can start with a blank page or an 
existing page or page template. Once you have selected this option click on your page at the point where 
you want the top left corner of your frame to be and drag down and to the right until the frame is the right 
size and shape. Note that the size and shape of a selected frame is displayed in the status bar at the 
bottom of your Illuminatus window.

You can resize and reshape the frame at any time by dragging any of the eight editing handles which 
appear around it when it is selected. You can also edit the size and position very precisely by editing the 
numbers for Top, Left, Width and Height on the Summary of the Frame Options dialog.

Illuminatus currently allows a maximum of 25 frames on any one page.

Add...Button



Align
 select Align from the Edit menu in Page View

This option allows you to ensure that buttons and/or frames line up neatly. You select a number of frames 
or buttons by holding down Shift and clicking on each of the items required. The eight black editing 
handles appear on each object to show they are selected.
You can now select one of the options to align the frames neatly to top, bottom, left or right.

Left
Right
Top
Bottom
Centre Vertically
Centre Horizontally



All Files
This is a special function in slideshows which allows you to tell Illuminatus to create a slideshow from all 
the files available in a directory when it runs. This is different from the Add All button which simply loads 
all the files in the current directory into the current slideshow.

This enables you to change the files in the directory at any time and not have to rework the slideshow. It is
particularly useful for creating PhotoCD slideshows.

Slideshows



AutoStart
This option allows an action, slideshow, video, sound or animation to take place automatically without any
interaction from the user.

This can also be useful reporting text to disk to track a user's progress or create a bookmark.

It can be used with the Delay option to make things happen automatically after a certain amount of time.



Bottom
 select Align...Bottom from the Edit menu in Page View

Selecting this option will align the bottom edge of all selected frames and/or buttons with the bottom edge 
of the object lowest down the page.

Left
Right
Top
Centre Vertically
Centre Horizontally



Browse Dialog
This is a standard Windows File dialog which allows you to find and open a file for use in the program.

Select the type of file you are looking for from the List Files of Type dialog if appropriate. The files 
available will vary depending on where in Illuminatus you are using the Browse dialog.

If necessary change to the drive where the file is by selecting the letter for the disk drive from the drop 
down list box labelled "Drive".

Select the directory by clicking on it in the list box labelled Directories.

Then select the file itself from the list box labelled File Name:



Button Options
Double-clicking on a button brings up this set of dialogs which allows you to assign actions to buttons. 
You can use buttons to move around the publication or to launch events. Buttons can be thought of as the
actions of your publication conveniently packaged as buttons. Think of them as commands, some can be 
set for the user to command others can be set to autostart and therefore effect something automatically. 
They can also be delayed so that they can synchronised with other events or create timed actions. 

Pile buttons on top of each other to create multiple actions. For example, to make a pop-up frame appear 
for a set length of time put a second button under the first which hides the frame which the first button 
shows. Then simply set the delay on the second button to the length of time the frame should be 
displayed.

Click on the item you would like further information on.

Several of the options available for buttons are mutually exclusive - you can only use a button to perform 
one main action. These are the primary actions and are represented by round radio buttons on the 
Summary page. There are additional, secondary actions which a button can be assigned at the same time
as one of the main functions and those are indicated by a square checkbox. Thus a single button could, 
hide a frame, stop the animation running on the current page, play a fanfare and move onto the next page
which enables you, in particular, to close down the current page successfully.



Button Options: Graphic
This option allows you to choose graphics to create graphical buttons. There are three button states: up, 
down and when the mouse is over the button but hasn't clicked on it, called highlighted. You can set a 
graphic for any or all of these by clicking on the large square box labelled Up Graphic, Highlight Graphic 
or Down Graphic, as appropriate. To tell Illuminatus you want a highlighted button click the Enable 
Highlight checkbox.

Then use the file list boxes at the bottom of the dialog to find the files you want and then click on the 
image to be used. It will appear in the box above to show you which one you have chosen.

It is up to you whether you have graphics for all the options. The highlight option, in particular, may not be 
appropriate. you do not need to set graphics for any state which is equivalent to setting the Invisible 
option and will make the button invisible though still functional.

If you change your mind about the image you want to use simply select another one or click the Clear 
button to empty that button state.

You can switch between a graphical button and a standard default one by clicking the Graphical Button 
checkbox on the Summary page on and off.



Button Options: Launch
This section of the Button options allows you to instruct a button to launch another program. This could be
another Illuminatus publication in a series or daisy chain publication. It could be an extra utility (such as 
using the calculator in the Catalog example provided with Illuminatus) or it could be the application you 
are providing training on so the user can test out what they have just learnt.

This is also the function which enables you to extend Illuminatus with ILX extensions. You launch your 
chosen extension which performs the additional function for you and then either simply drops back into 
your publication or relaunches your publication giving it a page number to jump to, as a parameter if 
required. For further details Extension Programs    or ILX Help File.

Type in the filename of the program you want to run or use the file list boxes to find it and then click on the
Add File As Launch button.

If the program needs a parameter or you want it to start with a particular file you can include this in the 
With Parameter box. If you want these files distributed with your publication you can check the Distribute 
Files option. 

You can choose whether Illuminatus closes down after it has launched the program by selecting Close 
Publication; if    you want Illuminatus to continue running in the background you should leave this option 
unchecked.

Don't forget that to include these programs in your multimedia publication you must have a licence to do 
so or the program and associated files must be public domain.

About Pathnames



Button Options: Report
This section of the dialog allows you to set up the options for reporting information to disk or to the printer 
via a text file.

Type the text you want to store in the large box provided and type the filename (and pathname if 
appropriate) into the box at the bottom. (See Pathnames    for further information.)

When the user presses the button the text you have typed in will be stored on disk in the file you have 
specified. You can ensure that this starts a new file by clicking the Overwrite radio button on or you can 
choose to add this to an existing file by clicking the Append option on.

You can print the text by clicking the Print File radio button on. This will print the whole file which you have
detailed in the filename box.

Users can provide the text to be reported to disk via frames which have been set to accept text input. You 
can store this on disk by selecting the Text Input option here. There is no need to give a text filename in 
this instance as this is set up on the Frame options dialog.



Button Options: Sound
This section allows you to setup a sound file for the button to play. Use the file list boxes at the bottom of 
the dialog to locate a WAV or MID or RMI file to play.

The sound file can play when the button is clicked and/or when the mouse cursor moves over the button 
and/or off the button by checking the appropriate checkbox(es) at the top of the dialog.

You can only play one Midi and one WAV file at once but if you want to stop a Midi file when you're 
launching a WAV file or vice versa you can click on the checkbox to Stop Existing Sound.

You can set the file to play repeatedly by clicking the Loop checkbox on. 



Button Options: Summary
The Summary on the front of the dialog allows you to set the actions for buttons and to switch the options 
on and off conveniently.

Several of the options available for buttons are mutually exclusive - you can only use a button to perform 
one main action. These are the primary actions and are represented by round radio buttons on the 
Summary page. There are additional, secondary actions which a button can be assigned at the same time
as one of the main functions and those are indicated by a square checkbox. Thus a single button could, 
hide a frame, stop the animation running on the current page, play a fanfare and move onto the next page
which enables you, in particular, to close down the current page successfully.

Click on the picture for further details.



Caption
Type the caption for the button in the Caption box provided. Unlike normal buttons the caption can be 
more than one line.

You can use captions on graphical buttons though they do not go down on the down graphic as there is 
no way to automatically establish how far it would need to go down (if at all). 

The caption is always displayed in the standard Window's system font. 

You can type in the text formatting codes 

You can, of course, take the graphic of the buttons into a paint package and add a caption in the font, 
position and colour you want. This also enables you to create a caption which drops on the down graphic.



Centre Horizontally
 select Align...Centre Horizontally from the Edit menu in Page View

This function lines all the currently selected objects along a horizontal line through the centre of each as 
illustrated...

Selecting Multiple Objects

Left
Right
Top
Bottom
Centre Vertically



Centre Vertically
 select Align...Centre Vertically from the Edit menu in Page View

This function lines all the currently selected objects down a vertical line through the centre of each as 
illustrated...

Selecting Multiple Objects

Left
Right
Top
Bottom
Centre Horizontally



Change Data Drive
 select Data Files from the File menu 

This option allows you to change the drive where Illuminatus will look for the data files and resources 
used in your publication while retaining any directory or subdirectory information.

If you have copied a publication from one drive to another for example, or if you are trying to edit a 
publication on your hard drive (C:) which is expecting all your resource files to be on a CD Rom in your 
drive (D:) or vice versa. 

Resources & Data Files
Check Location
Consolidate Project



Change Graphics File Extension
 select Data Files from the File menu 

This allows you to change the file format of graphics referenced by your Illuminatus publication without 
having to manually reload new images into the publication. So, for example, if you originally included 
PCX, TIF and JPG images in your publication but decide to keep all your graphics files in JPG format to 
save disk space you can convert the files themselves using Paintshop Pro or a similar package. Then you
can use this option to tell Illuminatus to change the references to all PCX and TIF files to reference JPG 
files instead.

This is particularly useful for customers who have used GIF and versions of the TIFF format in previous 
versions of Illuminatus. For legal reasons Illuminatus no longer support GIF file format or the version of 
TIF which is compressed using the LZW compression method as these are subject to a patent enforced 
recently. GIF has been replaced by PNG which Illuminatus does support.



Check Location
 select Data Files from the File menu 

This option allows you to check that all the graphics, text, animations, sound and video files used in your 
publication are where Illuminatus expects them to be and have not been deleted or lost. If they are not 
your publication will have blank or partially blank frames and pages (these will often appear black).

When you run this option Illuminatus checks the links with the files and lets you know if any can't be 
found. If the file is missing Illuminatus asks you if you want to reassign the file. You can then either locate 
the original file or find another file to replace it. 

Press Skip to ignore the current file, or Clear if you do not want it associated with the publication 
anymore. Press Abort to stop the Check Location process. Any changes made to that point will still be 
performed.

Resources & Data Files
Change Data Drive
Consolidate Project



Close Publication
 select Close Publication from the File menu 

Closes the currently selected publication. If the publication has been changed since it was last saved you 
will be given the opportunity to save it. Before closing your publication you may want to to use the Save 
Compressed option to reduce the disk space your publication uses up while still leaving it editable.



Closedown
This option allows you to program a button to close down your publication. The publication will close in 
the way set up in the Closedown option of the Publication Options. See Publication Options: Closedown



Commands
A comprehensive guide to all the commands and functions in Illuminatus.

GENERAL

Tools
Picture Editor
Word Processor
Sound Editor
Setup Tools

Window

Help

PUBLICATION VIEW
File

New...
New Publication
New Publication from Template

Open Publication
Save...

Save Publication
Save Publication As
Save Compressed Publication
Save All Publications
Save Publication As Template

Close Publication
Data Files

Check Location
Change Data Drive
Consolidate Project
Change Graphics File

Print
Printer Setup
Summary Info
Preferences
Exit

Edit
Cut
Copy
Paste
Delete
Select All
Deselect All
Edit Selected Page

Publication
Publication Options
Installation Setup
Insert Blank Page
Insert Page Template



Insert Page
Insert Master Page
Compile
Publish
Preview

PAGE VIEW
File

Save...
Save Publication
Save Publication As
Save Compressed Publication
Save Page As
Save As Master Page
Save Page As Template
Save All Publications

Export Page
Print
Printer Setup
Return to Publication View

Edit
Add

Frame
Button

Delete
Move

To Front
To Back

Align
Top
Bottom
Left
Right
Centre Vertically
Centre Horizontally

Page
Zoom 50%
Zoom 100%
Zoom To Fit
Next Page
Previous Page
First Page
Last Page
Preview



Compile
 select Compile from the Publication menu 
 F8

This is the function which allows you to build a finished and independent copy of the publication onto your
own hard disk. It is useful when creating presentations which will be viewed on the same computer they 
were created on (e.g: rolling demos) and for testing the true functionality of the publication (the Preview 
option within the Illuminatus editor works very differently and is, in particular, a great deal slower than the 
final version of the publication).

If you have not saved your publication you will need to do so. You will also need to give your multimedia 
publication a title before you Compile or Publish it.    (See Installation Setup for details.) This is not the 
same as the filename for the publication it is the title used in the menu bar and is required by Illuminatus 
to set up the data for your publication. Illuminatus will remind you about these two requirements if you try 
to publish or compile without them.

You should always compile to a separate directory. Do not compile to the same directory you have saved 
you publication in. You might like to set up a Compile directory and compile all you publications into 
subdirectories of that.

Compile also copies across files you have asked to distribute using the Programs option on Installation 
Setup. So if your program requires text files or data files so that you can check launching and text 
reporting features you should include them as described in Installation Setup

 Step-by-Step Compile

Related Topics 
Publish
Installation Setup
Publication Options
Preview



Consolidate Project
 select Data Files from the File menu 

This invaluable option allows you to quickly pull together all the components of your multimedia 
publication and store them in a single place alongside your editable Illuminatus file.

When you select this option a File Save dialog appears and allows you to choose a filename directory for 
your consolidated project. Usually these will be the same as the current filename and directory but you 
can move and/or rename your whole project by typing a different directory or filename in the dialog which 
appears.

Once you've clicked on OK Consolidate Project will gather together all the resources used in the project 
and put them into the same directory as the Illuminatus editor file (*.MPB) as selected via the File Save 
dialog. It will then reassign all the references in the publication to the new location. Illuminatus includes 
any files referenced in the publication whether they are actually used in the publication or not. This 
ensures that if you switch a slideshow back on all the files it needs will have been consolidated and you 
won't have to start all over again.

Once you've consolidated your project you can then safely delete any working files not copied to the 
consolidation directory in the knowledge that you didn't use them.

Check Location
Change Data Drive



Now Anyone Can Make Multimedia

ORDERING THE FULL VERSION

READ THIS FIRST 
The latest information including details of features added since the manual went to press.

New Features 
A brief introduction to features new in this version.

What Can Illuminatus Do for Me?
Introduction to multimedia publishing and the opportunities Illuminatus offers.

Quick Start 
A brief overview of how Illuminatus works.

Step-by-Step
Guides to how to perform certain actions or achieve certain effects.

Hints & Tips 
Tips for using Illuminatus and answers to technical problems.

Reference Guide 
A complete reference of functions and commands



Copy (Page View)
 select Copy from the Edit menu  
 Ctrl + C  

Copies the currently selected buttons and/or frames leaving the originals in the current publication and 
stores the copy on the Windows clipboard ready to be pasted back into a new position. All the information 
associated with the objects is copied.

Related Topics
Cut
Paste



Copy (Publication View)
 select Copy from the Edit menu  
 Ctrl + C  

Copies the currently selected page or pages leaving the originals in the current publication and stores the 
copy on the Windows clipboard ready to be pasted back into a new position or a new publication if 
required.

Related Topics
Cut
Paste



Creating Your Publication Efficiently
Experience has told us the following process is the most efficient way to create a publication using 
Illuminatus.

1: You will need to have a fairly good notion of the publication you want to create before starting out. With 
projects involving lots of pages and buttons it will be useful to have a definite plan for the publication. It 
will probably help to break the publication down into sections with a menu page for each section and 
subsection.

Things you will need to consider are the resources you have available, the maximum number of buttons 
you will need the number and position of frames, the size of resources you want to use.

2: Select or create a basic page design which is best suited to the bulk of the pages you want to use.

3: If required select or create an appropriate Cover/Contents and other primary page which looks and 
works consistently.

4: Build one copy of each page design you will be using into a new publication. These will be your master 
pages.

5: Create everything which will be consistent across your entire publication. This will probably include:
a background colour or graphic for the whole page,
a background colour or graphic for frames,
a company logo/motto and/or title for the publication,
borders for frames,

also create anything which will be consistent across the majority of your publication.
an Exit button,
a button for a particular page which needs to be reached from most other pages (e.g: contents or 

index),
hotspots,
hide buttons and frames you are not using on most pages.

You should also create sample text in the frames and set up the font, alignment and colour you will be 
using most consistently. This means that for every new page you create you will only need to edit the text 
and possibly font size rather than repeatedly selecting font and colour. 

6: Once you have edited the pages save them to disk as pages or as master pages.

7: Insert as many copies of your half-finished pages as you need and you are already half-finished.

8: Rename the pages to ensure there is no confusion. Ensure that any page you are connecting a button 
to has its final title.

9: With any publication over a few pages it is as well to divide it up into sections. Complete each section 
individually before moving to the next. Link it to a button on a contents page.



Creating an Index for Search
When you have used a button in your publication to provide a Search function in your publication 
Illuminatus automatically generates an index of keywords in your publication and the pages on which they
appear. When you comes to Compile or Publish your publication you can edit this index of keywords by 
pressing the Setup Keyword List button on the bottom of the dialog.

This brings up the following dialog..

The dialog basically allows you edit two lists of words, those which will appear in the index when a user 
runs a search and those which are excluded. You can select words in either list by clicking on them and/or
using Shift to select blocks of words and Ctrl to make multiple selections. You can then click the arrow 
buttons to transfer them to the other list. The Add All and Remove All buttons are provided for wholesale 
resetting of the list.
Illuminatus automatically creates an index of all the words in your publication to get you started. These 
can then be filtered using our Exclusion Dictionary which excludes word like "the", "a", "in" etc. by 
checking the box provided and clicking the Apply Filtering button. You will notice you can also ignore 
words under a given length or which are repeated frequently by typing the appropriate numbers into the 
boxes provided. Again you need to click the Apply Filtering button for the change to take effect. The 
filtering merely moves the offending words into the exclusion list from where you can put them back into 
the index if you want.

If you want to edit the page references of keywords already in the index simply click the Allow Editing 
checkbox. The Page Reference box will fill with all the page titles in the publication, highlighting those 
which are associated with the keyword. You can then edit these references by selecting or deselecting 
these references.



You can add words which don’t appear in your publication by typing them into the box beneath the Master
Index list and then adding the Page Titles you want associated with this word in the box underneath 
(Allow Editing must be on). When you have finished click the Add button to include the word and page 
references in the index. 



Cut (Page View)
 select Cut from the Edit menu  
 Ctrl + X

Removes the currently selected page or pages from their place in the current publication but stores them 
on the Windows clipboard ready to be pasted back into a new position or a new publication if required.

Related Topics
Copy
Paste



Cut (Publication View)
 select Cut from the Edit menu 
 Ctrl + X

Removes the currently selected page or pages from their place in the current publication but stores them 
on the Windows clipboard ready to be pasted back into a new position or a new publication if required.

Related Topics
Copy
Paste



Data Files
This option allows you access to a submenu provided for reorganising the links between your Illuminatus 
publication and the resources used in it.

Resources & Data Files
Check Location
Change Data Drive
Consolidate Project



Default Transparent Colour
 select Publication Options from the Publication menu

This allows you to set up the colour which will be used for making graphics transparent unless you 
change it for particular graphics in the places provided. The current colour is previewed in the box and 
you can change it by clicking on the Set Colour button which brings up a standard Windows colour 
selector dialog from which to choose. 

Note: For technical reasons you should only pick colours which are solid in 256 colour mode and not 
those represented by a series of different coloured dots (dithered).

 



Delay
This option allows you make events wait for a specified time before occurring. This is useful for delaying 
actions so that they coincide with another event. You can also use it to have events start automatically at 
a time later than when the page is first opened.

It is also useful when used with buttons to create timers for events. Use a second button underneath the 
first and set this button to stop whatever the first button started and then type in a Delay and you create 
an event which will last the specified time.

Simply type in the number of seconds or tenths of seconds you want the delay to be and then click the 
checkbox on to use the delay.

AutoStart



Delete 
 select Delete from the Edit menu.
Delete

Deletes the selected item(s) completely from the publication.

In Publication View it deletes selected pages.

In Page View it deletes the button(s) or frame(s) you have selected. A dialog will ask you to confirm that 
you want to delete the objects.



Deselect All
 select Deselect All from the Edit menu

Quickly deselects all the pages you currently have selected. 

Related Topics
Selecting and Moving Pages



Distributors
For price and availability of the full version of Illuminatus in your area please contact your nearest 
distributor. If you experience any difficulty getting your copy of Illuminatus please contact Digital 
Workshop direct.

ILLUMINATUS - Order Form 
Yes. Please rush me the full version with free CD-Rom, manual and lifetime support.
Name:................................................................................................................
Organisation:.....................................................................................................
Address:............................................................................................................
...........................................................................................................................
...........................................................................................................................
Country....................................................PostCode:.........................................
Telephone................................................Fax....................................................

Illuminatus v3.00
........ copies at the special price of ..................= ...........................
Illuminatus SuperPack
........ copies at the special price of ..................= ...........................
plus postage and handling ..................=............................
sales tax if appropriate =............................
Total =............................

__ Please charge my credit card: Access/Visa/Mastercard/American Express
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Drawing Frames and Buttons
To add frames or buttons you select Add|Frame or Add|Button from the Edit menu or click on the 
appropriate button on the toolbar. You then click on your page where you want the top left corner of your 
frame or button to be and then drag down and right until the object is the right size and shape before 
releasing the mouse button.

Related Topics

Add
Frame
Button

Delete
Move

To Front
To Back

Align
Left
Right
Top
Bottom



Edit (Page View)
This menu provides functions for creating your own page designs or editing existing ones It enables you 
to add frames and buttons, to align them and to order the layering of overlapped objects by bringing 
selected objects to the front or moving them to the back

To perform any of these options simply select the object(s) required (Use Shift+Click to select multiple 
items) and then choose the appropriate function or click on the relevant button on the toolbar if one is 
available.

Commands
Undo
Redo
Cut
Copy
Paste
Paste in Original Position
Add

Frame
Button

Delete
Move

To Front
To Back

Align
Left
Right
Top
Bottom
Centre Vertically
Centre Horizontally

See Also
Editing Page Elements



Edit (Publication View)
This menu allows you to perform all the standard Windows editing functions on your selected page(s). It 
also allows you to switch to Page View for editing of your Illuminatus page.

Cut
Copy
Paste
Delete
Select All
Deselect All
Edit Selected Page



Edit Selected Page 
 select Edit Selected Page from the Edit menu.
Enter

Switches the program to Page View to allow you to edit the elements on a page. If you have more than 
one page selected Illuminatus will go into Page View with the first page in your selection.

Related Topics
Frame Options
Button Options



Editing the Page Contents
To edit the contents of frames, buttons and whole pages you simply double click on the appropriate 
element or press the Enter key when the object is already selected and then select the tab for the option 
you wish to edit.

Page Options
Frame Options
Button Options



Exit
 select Exit from the File menu
Alt+X

Closes the program down, giving you the option of saving any publications which have changed.



Export Page
This function allows you to export a full size copy of your page to a disk-based bitmap graphic file so that 
you can edit it or cut out portions using a paint program such as Paintbrush. If you are running in 256 
colour mode the exported graphic will be a 256 colour graphic. If you are running in 16 colour mode the 
graphic will reflect that.

When you run this option you will be presented with a standard file save dialog. Use the drive and 
directory list boxes to find the location where you want the page save and then type the filename for the 
file into the File Name box.

Useful hint
One use for this is to quickly turn text into graphics. Export the page and then cut out the pieces of text 
and save them as graphics. You can then use these graphics of your text to create text slideshows and 
other standard presentation effects. You can temporarily give the relevant frame a border for reference 
when you come to cut the item out. 
Another simple use for this is to flip or invert a piece of the background texture or to draw a white line 
around the top left and black around the bottom and right to create and embossed or inset look to a 
frame.



Extension Programs
You can extend Illuminatus to do anything you want by linking it with Extension programs. These are 
programs which add specific features to Illuminatus in a modular way so that the basic program remains 
uncluttered and you don not distribute functions you do not need.

Several ILX extension programs are provided with the program and full instructions for using them are 
provided in a separate help file. They provide functions to swap pages while your publication is running, 
keep scores, play your pages randomly and make conditional jumps around your publication. (Click here 
for the ILX Help File.) We have tried to design them so you can just use them without having to set 
any/many parameters and they will work. Some will need specific text files created by other buttons in 
your program but we've made it as simple as possible. The full range of parameters are also there for 
greater control when you become familiar with using them. 

If you are a programmer yourself then you can create extension programs in any Windows programming 
language. If you are not a programmer then you simply buy in the module you need from ourselves or 
from other third parties and concentrate on the part of the multimedia publishing process you want to.

Extension programs can be launched using the Launch Program function and can either run over the top 
of your publication page or can replace it. If you want the extension program to return you to a certain 
location in your publication you should close the publication when the extension program is run (Select 
Close after Launch on the Launch dialog) and then, when it is finished, it should run your publication with 
the title of the page you want displayed first passed as a parameter. For example to go to the Contents 
Page of a publication with the filename catalog.exe your extension program would close down by issuing 
the command... catalog.exe contents 

Ideal uses for this function are search programs, order programs, specialised picture viewers, scoring 
programs and printing programs. Several of these are available from Digital Workshop at a small extra 
charge.

Important Note: The most common error when using extension programs is not getting the pathname 
right when the project is published. For further guidance see Pathnames

See Also
Launching Other Programs



File (Page View)
This provides access to file and program management options such as file loading and saving functions, 
printing with reference to the current page.

Save...
Save Publication
Save Publication As
Save Compressed Publication
Save Page As
Save As Master Page
Save Page As Template
Save All Publications

Export Page
Print
Printer Setup
Return to Publication View



File (Publication View)
This provides access to file and program management options such as file loading and saving functions, 
printing and    program preferences.

New...
New Publication
New Publication from Template

Open Publication
Save...

Save Publication
Save Publication As
Save Compressed Publication
Save All Publications
Save Publication As Template

Close Publication
Data Files

Check Location
Change Data Drive
Consolidate Project
Change Graphics File

Print
Printer Setup
Summary Info
Preferences

There is then a list of the four publications you used most recently which provide a shortcut way 
of opening those files. Simply select on the one you want.

Exit



First Page
 select Next Page from the Page menu.
Home

Takes you to the first page in the current publication. 

You can use the Home key as an shortcut/alternative.

You can also move to any page in your publication by selecting its title from the drop down list box in the 
toolbar in Page View.

Related Topics
Zoom 50%
Zoom 100%
Zoom To Fit
Next Page
Previous Page
Last Page
Preview



Fonts
Illuminatus supports True Type fonts and so allows you to use any font you currently have installed under 
Windows. There is no need to restrict your choice to those you think your readers will have or to distribute
the fonts with your publications as Illuminatus automatically converts them to graphics when you compile 
or publish your document.

The exception to this is text displayed in scrolling text boxes which will need to find a font at run time. If 
the font you have chosen is not available the publication will find the nearest match so your text will still 
display but its appearance may be different.

When selecting fonts with which to display text you should think about the manner in which they will be 
read. Small sizes and fancy typefaces will probably not work well when displayed on screen; they are 
particularly unsuitable for rolling demos where the message must get across quickly. As with all publishing
it is advisable to limit yourself to one or two typeface styles in any one document as this give the 
publication consistency and coherence.

Text



Frame Border
You can give your frame a border in one of several different styles by selecting it from the drop down list 
of those available. The current version of Illuminatus includes the following.



Frame Options
Whenever you double-click on a frame you call up this set of dialogs which allows you to setup the 
contents on any frame. Frames can contain text, graphics, animations, video or slideshows. A frame can 
contain all these elements although you cannot run a slideshow, video and/or animation at the same time,
whichever is launched last will overplay the other.

Click on the item you would like further details on.

Related Topics
Text
Graphics
Slideshows
Animations
Video



Frame Options: Background
You can add a background colour to your frame. Clicking on the Palette button brings up a standard 
Windows colour-selection dialog from which you can choose any of the ready-made colours or create 
your own by clicking on the Define Custom Colours button.

You can also load a picture in any of the supported graphics formats by using the file list boxes at the 
bottom of the dialog to find it on your disk. 

Checking the Scale to Fit option will resize the picture to fill the background, with the Keep Aspect Ratio 
option checked the picture will not be stretched out of proportion in order to make it fit. The scale to fit 
option is not relevant for vector format pictures such as .WMF.

The background picture can be a texture, an illustration or a graphic which designs the publication in a 
certain way. It can also be Transparent in which case a chosen colour in the picture will be ignored and 
the background will show through this will allow you have an irregularly-shaped graphic. You can set this 
colour by clicking the Set Colour button and choosing from the palette which comes up.

Transparent



Frame Options: Animation
You can assign an animation or video clip to play in an Illuminatus frame by selecting the relevant file 
using the file list boxes at the bottom of the dialog. You can load a FLI or FLC animation, an AVI video file 
or an MPEG movie. The latter needs specialist hardware to be replayed.

As with most elements in Illuminatus you must give the resource a title by which it is known throughout 
the program. This can be up to 25 characters long and can contain spaces to allow you to give it a 
descriptive name.

The animation can start up immediately the page is opened using the AutoStart option.    Whether it is 
launched by a button or automatically it can be synchronised with a later event using the Delay option. 

The Scale to Fit and Keep Aspect options only apply to AVI and MPEG files and not to animations

If you want the file to play continuously you can set the Loop option on.

One of the special new features in Illuminatus 3 is From CD which allows you to tell your publication to 
load the animation or video from CD. This allows you to install your publication to your user's hard disk to 
run it at its fastest but leave the movie files on CD so that they don't require massive amounts of hard disk
space. There is no need to be concerned that the user may have their CD Rom drive installed on a 
different letter to the one you've set up because with this option Illuminatus finds the first CD Rom drive 
on the system automatically.



Frame Options: Slideshow
You can set up a slideshow to play in any Illuminatus frame. This feature allows you to setup a series of 
bitmap graphics to appear at intervals of your choice. 

As with other tab dialogs you can search for the pictures you want using the file list boxes at the bottom of
the dialog. you can then add these to your slideshow by clicking the Add button or simply by double 
clicking on the file required. If you want to add all the files in the current directory click the Add All button.

There is a special option <All Files> which instructs your publication to automatically search for all the 
image files in the directory when it runs, and display those in the slideshow. This allows you to change the
list of graphics available in that directory and not have to recreate the slideshow. Obviously the graphics 
you require must be in the same directory on your user's computer. This is particularly useful for creating 
slideshows of PhotoCD images as they are always in the same directory on the CD.

The Delete button removes selected files. The Up and Down buttons move the selected file up or down in 
the slideshow.

Slideshows can consist of only one picture and so (with the Delay option) allow for timed display of single 
elements on your page.

A slideshow can be launched by a button and/or can start automatically by checking the AutoStart option.

The slideshow can be made to fit each picture into the frame by using the Scale to Fit option and can 
retain the original proportions using the Keep Aspect option.

One of the special new features in Illuminatus 3 is From CD which allows you to tell your publication to 
load the graphics for the slideshow from CD. This is useful if you have large slideshows as it allows you to
install your publication to your user's hard disk to run it at its fastest but leave the image files on CD so 
that they don't require massive amounts of hard disk space. There is no need to be concerned that your 
user may have their CD Rom drive installed on a different drive letter as Illuminatus finds the first CD Rom
drive on the system automatically. It also means that you can run slideshows of PhotoCD images, 
particularly when used in conjunction with the All Files option.

Transparency
Slideshow can now be displayed transparently so they can appear over the background or build up in 
layers.

Special Effects
You can choose the way the pictures appear in a slideshow by using the Effects option.

Animations
By building a slideshow from the frames of an animation created by a bitmap animation package such as 
Animation Works Interactive or by creating them manually in a paint program you can create your own 
animations in Illuminatus. You need to set the timing of the slideshow to 0.1secs for smooth animation. 
The speed of animation will depend on the size of the graphics you are using and the speed of your users
computer. 

This can, however, be particularly useful for producing animated buttons, several of which are provided 
with the program.

Related Topics
Recreating Standard Presentation Effects



Frame Options: Summary
The Summary on the front of the dialog allows you to set some of the properties of the frame and to 
switch properties set up on the other sections on and off conveniently.

Click on the area of the dialog on which you require further information.



Frame Options: Text
This section allows you to place text into your frame either by typing it into the box provided or by using 
the file list boxes at the bottom of the dialog to find a disk-based file of the text you want to use and then 
clicking the Import button to load it into the frame.

Click the Font button to bring up a standard Windows font selection dialog for you to choose a typeface, 
font size, style and colour from any of those installed on your system. 

If you have a lot of text to display in a small area you can click the Scrolling checkbox on and the frame 
will turn into a scrolling text box. Unlike standard Windows scrolling text boxes these are transparent and 
so can be displayed over the background colour of your frame or page or even over pictures. Unlike static
text, scrolling text does need to use a font when being displayed so if your publication is to be viewed on 
a different computer you will need to ensure that the other machine has the same font or choose one 
which is likely to be on most systems e.g: Arial or Times. If the font is not present the text will still display 
but Illuminatus will ask Windows for the closest font available or use a standard system font which may 
change the appearance of your text.

Note: The scrollbars for scrolling text boxes only display in Preview mode and do not appear in Page 
View.

You can highlight particular parts of your text by dragging the cursor over them to select them and then 
clicking on one of the buttons to the right of the box to apply Bold, Underline, Italic and a particular colour 
chosen beforehand from a drop down list below the Apply Colour button. You will notice that doing this 
inserts codes before and after the highlighted section. These can be inserted manually if you want by 
typing them in just like any other text which means they can be included in text files created in separate 
word processors and even used in button captions. You can also use these codes in scrolling text boxes. 
A Remove Format button is provided for you to easily remove all the formatting codes from your text 
should you change your mind.
Text Formatting

Text can be used along with pictures or background colour and will appear over them.



Frame Title
This option on the Summary of the Frame Options dialog allows you to set a title for your frame so that it 
is visible elsewhere in the program. The primary use for this is for popup frames and when you check the 
popup frame checkbox Illuminatus automatically provides a default frame title which you can, of course, 
subsequently edit to suit.

Show Frame 
Hide Frame
PopUp Frames
Titles and Filenames



Frequently Asked Questions
Why did that function not work/crash?
The most frequent cause of problems with Illuminatus is a lack of disk space while Illuminatus is in the 
middle of something. If you experience problems with Illuminatus check your disk space and other system
resources and try again. 
This is particularly true when Compiling and Publishing. For this reason we have introduced some 
messages to warn you if you are getting low on disk space. Please note that this is only a warning and 
small publications may still fit into the space you have available. You will also be told if the 
Compile/Publish failed to complete properly but the advance warning, we hope will help stop the 
frustration of compiling a large publication only to find it has failed because of lack of disk space.

Why are some frames and pages black or blank in my publication when everything looks set up 
correctly?
This usually indicates that Illuminatus cannot find some of the resources (images, sound, videos etc.) 
used in the publication. This will often happen if you loading a sample publication from a CD Rom such as
the one which comes with Illuminatus or if you are working on a publication on a different machine or on a
different network drive. 

If it is only the drive which has changed you can use the Change Data Drive to change the drive itself. 

You can also use Check Location to establish which resources are missing and why and to reassign the 
link to the new location.

Why can't I click on the editing handles for a particular frame when the one next to it works fine?
You cannot select objects through other objects. You must bring the object to the front, if necessary by 
sending the other object to the back. This is also true of the editing handles relating to objects so beware 
of this when trying to edit objects immediately alongside each other as they do not look as though they 
overlap but their editing handles may be "underneath" the neighbouring object and will not be selected

Why don't I get a scrollbars when I click on the scrolling checkbox?
The scrollbars on a scrolling text box only appear in Preview mode and in your finished publication. They 
do not appear in Page View.
Furthermore, scrollbars will only appear if the frame is too small for the text it contains.

Why do filenames keep disappearing from the bottom of my slideshow list?
Slideshows can only contain 50 images. If you have included more Illuminatus will ignore those beyond 
50. If you need more images simply create two slideshows and delay one until the end of the other. 
Slideshows.

Why is my publication so slow in 16 colour VGA mode?
If you run a 256-colour publication on a system in 16-colour VGA mode Illuminatus optimises each page 
to ensure that the publication looks the best it can (the alternative would be entirely unacceptable quality 
graphics). This can slow the publication down. The only alternative is to create a dedicated 16 colour 
version.

Why won't the Report Text dialog let me specify a filename for the text to be stored in when I'm 
select the Text Input option?
You set the filenames for the text files where text input by the user will be stored on the Frame Options 
Summary and not on the Report Text dialog. This enables you to specify different files for different input 
frames but record them on disk with one button.

Why do my buttons no longer work?
Check the details on the Button Options: Summary page for these buttons to see if the title for the object 
they were pointing at has been lost. This usually happens because the title for the page/frame has been 
changed since it was connected to the button.



Why can't I use the keyboard to access items from the tabbed dialogs?
Because of technical limitations within Windows the Illuminatus tabbed dialogs do not provide keyboard 
support, you will need a mouse to use the program. Apologies for any inconvenience caused.

Why did I get a Divide by Zero error when loading my publication?
This almost certainly indicates that your .MPB publication file has been corrupted somehow or if you 
suddenly run out of disk space (e.g: someone copies something across the network) before Illuminatus 
has a chance to notice the lack of disk space.

Why do I get a flash of black or white where text input frames, video or scrolling text frames have 
been?
This is an unavoidable result of the area of the page being updated at a slightly different time to the main 
page under the control of the Windows operating system. This may be lessened in Windows 95. We are 
currently investigating the possibility of taking over this function ourselves to avoid the problem.



These checkboxes allow you to turn of the contents
set up on the other tabs conveniently. For further 
information on each click on the relevant tab at the 
top of the picture.



From CD
This is a special option for slideshows, animation and video files which instructs your publication to 
retrieve the file required from CD Rom rather than incorporate it into your publication. This is especially 
useful for files which would otherwise take large amounts of disk space to install and for creating 
PhotoCD slideshows.

It does not matter if the CD is in a different drive letter to the one you set it up on as Illuminatus will 
automatically find the first CD Rom drive on the system and look there.

Slideshows
Moving Images



Goto Page
This allows you to set a button to move the publication to another page. Select the page required from the
drop down list of Page Titles provided. It is as well to have set up all the page titles before you start 
assigning buttons to move to them as the button will not find the page if you change the name 
subsequently.

In addition to the titles of specific pages there are three special variable pages you can 
choose...<Forward>, <Backward> and <Previous>. The first two take your publication on one page or 
back one page as appropriate in the order in which the pages appear in publication view. The third option 
takes the publication back to the last page your user was one irrespective of where that it.



Graphical Buttons
You can now have graphical buttons in Illuminatus. There are three button states: up, down and when the 
mouse is over the button but hasn't clicked on it, called highlighted. You can set a graphic for any or all of 
these via the Button Options: Graphic dialog. 

You can set graphical buttons to be transparent so that the background is ignored and this enables you to
have irregularly-shaped buttons of any shape you like.

A great many graphics for buttons are provided with the program, usually these will include a "d" or "dn" 
for down graphics and "h" for highlight graphics.



Graphics
Graphics are very important in Illuminatus. They can be used as backgrounds or illustrations in both 
frames and page backgrounds or they can impose a design on an Illuminatus page as several of the 
backgrounds supplied with the program do.

To import a graphic simply click on the frame or page background you want the graphic to be in and then 
locate the file you want by using the file list boxes at the bottom of the Background dialog. 

Checking the Scale to Fit option will resize the picture to fill the background, with the Keep Aspect option 
checked the picture will not be stretched out of proportion in order to make it fit. The scale to fit option is 
not relevant for vector format pictures such as .WMF or .CGM.

ClipArt
Illuminatus supports all the major graphics formats and so enables you to utilise your existing graphics 
and draw on the wide range of clipart available from ourselves and from third parties

Formats Supported
Illuminatus will import the following graphics formats: .BMP. .PCX. .TIF, .GIF, .TGA, .WPG, JPEG, .WMF 
and .CGM

Palettes
If you are displaying 256 colour graphics in super VGA 256 colour mode it stands to reason that 
displaying more than one graphic may need more than the 256 colour slots available. This can cause 
problems if you want to display two or more 256 colour graphics on the same page as the palettes of the 
two graphics may be different and interfere with each other. This is called palette clash but Illuminatus 
now includes a special OmniPalette function to avoid the problem.

Important Note: If you are displaying a graphics format in a lower graphics mode e.g: a 16million colour 
graphic in 256 colour mode or a 256 colour graphic in 16colour mode Illuminatus does not attempt to 
simulate the correct colours for the image when displaying it in the editor. The image may therefore 
appear very poor until you publish or compile you publication.

Sound
Moving Images
Text



Help Menu Option
Contents 
Takes you to the Contents page of this help file.
Read this First    
Opens up the Read this First section of this help file.
Reference Guide 
Takes you to the a comprehensive guide to the functions of Illuminatus
Commands 
Takes you to the list of all the commands in the program.
Keyboard Shortcuts 
Takes you straight to a list of the keys you can press to access certain Illuminatus functions without using 
the menus or toolbar.
Using help 
Provides help on using help if required.
Technical Support
Sections providing technical support and problem solving.
About
Shows a page showing details of Illuminatus including the version and the licence details.



Hide Frame
This option on the Summary page of the Button Options dialog enables you to instruct a button to hide a 
popup frame which has been displayed earlier by a Show Frame command. 

The fame must have been set as a popup frame by checking the popup frame checkbox on the Frame 
Options: Summary dialog. 

Click the Hide Frame checkbox and then select the frame you want by clicking on its title in the drop down
list of those available the right of the checkbox.



Hints and Tips
Cutting and Pasting Text
You can cut and paste text between the Illuminatus Text box and any other Windows application using 
Ctrl+C for Copy and Ctrl+V (or Shift+Insert) for Paste.

Using Export Page
One use for the Export Page option is to quickly turn text into graphics. Export the page and then cut out 
the pieces of text and save them as graphics. You can then use these graphics of your text to create text 
slideshows and other standard presentation effects. You can temporarily give the relevant frame a border 
for reference when you come to cut the item out. 
Another simple use for this is to flip or invert a piece of the background texture or to draw a white line 
around the top left and black around the bottom and right to create and embossed or inset look to a 
frame.

Publish A Sample Page
When you have decided on the colour scheme, background and the general type of content for your 
publication you may wish to publish a sample page to the colour mode you have chosen just to check that
the colours will reproduce in that graphics mode properly before you spend time completing the 
publication.

Big Publications
Publications with a large number of pages can be slow to work with so you may like to consider breaking 
the publication down into sections and creating each of these separately. You can either daisy-chain them
or if you need your final publication to be a single file you can cut and paste the modules together at the 
last minute.

Titles
Illuminatus uses title extensively to label items in the publication. In particular you will need them for 
slideshows, animation, video and frames or these elements will not be visible throughout the rest of the 
program. (See Titles and Filenames    for further details).

Speed of Operation
You can speed up the program during editing by switching off the thumbnails used to preview pages in the
Publication View and by not previewing bitmaps in Page View. Both of these options are available from 
the Preferences item on the File menu.

For obvious reasons display of multimedia pages from within the Illuminatus editor using the Preview 
option will be considerably slower than the final Compiled or Published version.

Creating Illuminatus Pages in Your Favourite Application
If you want to create your pages or parts of your pages in other applications you can do so. You can even 
go so far as to design the whole page in another application and then either export it as an appropriate 
size bitmap, or as a vector (.WMF or .CGM) graphic or simply grab a screenshot using Alt-PrintScreen. 

The result can be imported into an appropriate Illuminatus frame and the buttons connected as required.

Getting Bitmaps the Right Size
Bitmap graphics will invariably work best if they are the same size as the frame they are going into. This 
especially important for sixteen colour graphics. If sixteen colour graphics are dithered reducing them to fit
in an Illuminatus frame can give them an unwanted tartan effect. 

In the status bar at the bottom of the screen Illuminatus tells you the size and position of the button or 
frame you have selected.



If you are creating your bitmaps specially you may find it helps to save the Illuminatus page or the page 
template you are using them in as a bitmap using Export Page (see Export Page) from the File menu in 
Page View. You can then load this into your paint program and use it for reference in creating your 
bitmap.

Rolling Demos
For rolling demos variation in the graphics is most eye-catching. Changes in the predominant colour of 
the screen and strong main graphics can be most effective in exhibition situations where attention-getting 
is the key. This can, however, make the presentation uncomfortable to read so for shop windows it is less 
useful. In both cases a consistent basic design should be maintained to let viewers quickly read the 
information you are presenting once you have caught their attention.

Background Music and Sound Effects
You can play a WAV file over the top of a MID file without stopping the latter. So you can, for example, 
use a MID file for the background music and then use a WAV spot effect or fanfare over it as required. 
Don't forget that AVI files can have WAV sound tracks in them and so can interrupt any other WAV files 
you have running.

SoundBlaster Pro
If you have a SoundBlaster Pro card we recommend you get the Super SAPI driver for it as this greatly 
improves the quality of output under Windows.

All the midi music supplied with Illuminatus is intended for optimised for such a setup.

Frame Borders
The Frame Options dialog allows you to switch the border for a frame on or off (by choosing None) or to 
add one of several different styles. To add more sophisticated borders you can use frames within frames. 
Use the outer frame to hold a graphic border for the text, graphic, animation or video in the inner frame.

Video and Animation Preview Bitmaps
Frames in which video or animations will run can leave large empty gaps but you can grab a frame from 
the video to use as a preview as follows:
Run the Media Player accessory which comes with windows and open the appropriate video or animation 
file. Using the slideshow buttons on Media Player step through the individual frames of the file until you 
find one you want to use to represent the file. Copy it to the Clipboard by pressing Alt-PrintScreen. Open 
Paintshop Pro and Paste the clipboard file into there. You can then edit and save the video frame as a 
bitmap graphic which can be displayed in the same Illuminatus frame that the video or animation itself will
appear in. 

Colour Schemes
Colour can be the make or break of any presentation and multimedia publishing is no different. For those 
untrained in design we recommend that the basic design is limited to a neutral colour (grey, black or 
white) with one other colour. Using grey as the main colour gives you dark and light grey, plus black for 
shadows and white for highlights. This will also give the multimedia publication a Windows feel and 
Windows users will feel comfortable with it. This also means that you can easily find examples of colour 
schemes which work and ones which don't by your own response to the colour schemes employed by 
Windows programs.

Sixteen vs 256 colours
Using 256 colours in your publication is always preferable and for scanned pictures, digitised video or 
sophisticated colours it is essential. In 256 colours your graphics will be much closer to photographic 
quality than in sixteen colours. 

It doesn't matter whether your user has a system capable of displaying 256 colour graphics as Illuminatus
has a special automagic feature which recognises what mode it is running in and adapts 256 colour 



graphics to 16 if required. 

The real problem with 256 colour graphics is that they can be very large.

If you wish to create a sixteen colour publication best effects in sixteen colours are achieved by avoiding 
dithered colours wherever possible. Stylish effects can still be achieved using mono or sixteen colour 
graphics, particularly by using bold icon or symbol type images. (Several examples are supplied in the 
samples which accompany this program.) 

If your publication is to be displayed in 16 colours but contains graphics intended for display at 256 
colours (or higher), particularly greyscale or colour scans or photographic images, then you should 
compile it to sixteen colours so that you can examine the consequences. If you want greater control over 
how the sixteen colour graphics are created you should reduce them yourself. We recommend PaintShop
Pro for this as some of the dithering options it offers can be quite attractive in themselves.

NOTE: Both Animator animations and video files will display on standard 16 colour VGA systems but the 
effects may be unpredictable. AVI video general works quite well but the colours in Animator files may not 
convert properly. Animations produced by Windows bitmap animation programs like Animation Works 
Interactive, CorelMove etc. can create sixteen-colour animations which avoid these problems but are not 
suitable where large areas are being animated.

Reducing File Size
If you need to reduce the size of your final publication consider some of the following options. Reducing 
the number of colours in a graphic can also drastically effect the size of the file involved. 
Pictures with lots of    detail and variation in colour or tone will compress poorly so try to replace them with
graphics with flatter areas of colour. 
If you have reduced the number of colours in a graphic using a dithering option try and alternative dither 
as some nice-looking dithers can produce files which do not compress very well at all. 
As a last resort consider whether any graphics can actually be removed. 
Consider replacing WAV files with midi files or removing them completely as these can be very big and do
not compress very well.

Consistent Style
If you a creating a series of documents on the same theme or for the same purpose it is advisable to 
choose a "house style" for your documents. Base the bulk of your publication on one or two page 
template designs - the templates supplied with Illuminatus often have several variations on designs for 
just this purpose. Use this page consistently with the same colour scheme, the same fonts and the same 
position for your company logo or the motto/title for the presentation.

Getting Ideas
Keep your eyes open for other multimedia programs, demonstrations and presentations which work 
particularly well and try to decide what makes them successful. 

Television is a similar medium to multimedia publishing so TV programs, particularly current affairs and 
news programs, can often provide inspiration for page designs or simply illustrate effective techniques. 
You will also see reviews of many multimedia products in specialist magazines which can often prompt 
your own creativity.

Creating Your Publication Efficiently



HotKey
This option allows you to assign a keystroke to a particular button and thereby allows the user to press a 
key to perform an action rather than click on the button with the mouse.

Simply type the character you want to use in the box provided. This function does not differentiate 
between uppercase and lowercase so "A" or "a" in the hotkey box will let the button be activated by the 
user pressing "a" or "A".

You can also use a space in the hotkey box although this is not actually visible it will work.



Hotspots
By checking the Invisible option on the Summary of Button Options dialog buttons can be used as 
hotspots as they are not visible but can still perform the action assigned to them. 

They can be placed on a graphic so that when the user clicks on the graphic he/she is clicking on the 
invisible button. 

By highlighting specific words in your text and using an invisible button beneath it you can simulate 
hypertext.

You can use a custom cursor to highlight hidden buttons if required.

Button Options: Summary 



Important Considerations
Speed
Illuminatus will run on any PC which will run Windows 3.1 but the program will be more enjoyable to work 
with on a 66Mhz 486 or better. If you are running it on a slower machine you can speed up the program 
by switching off the thumbnails used to preview pages in the Publication View and by not previewing 
bitmaps in Page View. Both of these options are available from the Preferences item on the File menu.

For obvious reasons display of multimedia pages from within the Illuminatus Editor using the Preview 
option will be considerably slower than the final compiled or published version. This is particularly true 
when using large graphics in compressed formats such as JPG.

Volume Levels
WAV and MID files are produced differently on any soundcard and the difference in the volume levels can 
be quite considerable. Your sound card may come with a mixer utility which allows you to set up the 
relative volumes of playback. With SoundBlaster this is the SBMixer utility. Adjust the controls until WAV 
and MID files are played back at equal volumes. You may also wish to use the Wave Editor provided with 
the program to change the volume of the WAV files to match midi if you are using both in the distributable 
publication.

Page Zoom
Please note that some details of the page may not be properly visible if the page view is reduced too 
much. This is particularly true of any colours which are dithered. Single lines of pixels including frame 
boxes may temporarily disappear.

Distributing Other Programs
When you want a button to launch a program for you Illuminatus will need the complete location for the 
program (e.g: c:\windows\calculator.exe). If the program is distributed with the publication this is not 
necessary as Illuminatus will put it into the same directory as the publication so that it knows where to find
it.

There is an option which allows you to include the program with the distributable version of the publication
so that it is installed on your reader's computer. This is the only way to ensure that the reader has the 
program and that it is currently installed. But obviously you can only distribute these programs if their 
copyright-holder allows it or if you have a licence to do so.

You will also need to ensure that Illuminatus also distributes any supplementary files the program needs 
(e.g: special drivers, sound files or .DLL's). A dialog asking for details of supplementary files will prompt 
you when you set up a button to launch a program.

Other files
All the elements you include in the publication (graphics, text, sound, animation, video clips) are built into 
the distribution file when Illuminatus creates you publication so there is no need to distribute the original 
files.

Text
Remember that even users familiar with computers are not as used to reading screens as they are paper. 
If you need a lot of text for any reason try to break into down into manageable chunks. This is particularly 
important in rolling presentations where text should be a large bold style so that it can be read at a glance
and get its message across quickly or entice the viewer in to read the smaller text. Avoid large amounts of
text unless the publication is an online book. If you have a lot of text to display split it over several pages 
and make it exciting to look at.



Insert Blank Page
 select Insert Blank Page from the Publication menu in Publication View

This option allows you to add an entirely blank page to your publication on which you can draw a template
of buttons and frames of your own design.

Once you have selected this option the cursor will change to show you have a page to paste and you can 
then click in your publication window at the point where you want the page inserted.

Related Topics
Editing Page Elements
Selecting and Moving Pages
Insert Page Template
Insert Page
Insert Master Page
Save As Master Page
About Master Pages



Insert Master Page
 select Insert Master Page from the Publication menu in Publication View

Allows you to insert a page which has been previously saved to disk as a master page. All its properties 
and contents will be included. To build your publication quickly you can check the Multiple Copies option 
and type the number you require in the box provided.

Related Topics
Selecting and Moving Pages
Insert Page Template
Insert Blank Page
Insert Page
Save As Master Page
About Master Pages



Insert Page
 select Insert Page from the Publication menu in Publication View

Allows you to insert a page which has been previously saved to disk. All its properties and contents will be
included. To build your publication quickly you can check the Multiple Copies option and type the number 
you require in the box provided.

Related Topics
Selecting and Moving Pages
Insert Page Template
Insert Blank Page
Insert Master Page
Save As Master Page
About Master Pages



Insert Page Template
 select Insert Page Template from the Publication menu in Publication View

Allows you to insert a ready-made page template from the wide selection provided with the product or 
those you have saved to disk using the Save Page As Template option. These already contain frames and
buttons and are designed in a variety of styles for a variety of roles.

You can limit the list of templates to a specific style by selecting that style from the List Files of Type box 
at the bottom of the dialog.

Related Topics
Selecting and Moving Pages
Insert Blank Page
Insert Page
Insert Master Page
Save As Master Page
About Master Pages



Installation Setup
 select Installation Setup from the Publication menu in Publication View

This option allows you to set your preferences for the way the distributable version of your multimedia 
publication will be installed. This includes things like where the publication will be installed

Click on the aspect you want further details on.

You can select a title (you must have a title for the publication before it can be published). This title is 
used as your publications name under Windows - it is used under the icon and in the title bar of the 
publication's window. The title is not the same as the filename for the program element of your 
publication.

You can setup the directory which will be used as the default when your reader installs your publication. 
(They can change it to suit if required.)

You can also choose an icon which will represent the publication in your reader's Program Manager. Use 
the Browse button to locate and open the file you want.

You can also set the size of disk you will be publishing your publication on. Click on one of the three 
options provided to select either 3.5" HD, 3.5DD or 5.25HD disks. This information is only used when you 
Publish your publication. The Compile function does not divide you publication into disk-sized chunks. If 
you wish to produce material for CD Rom you can ignore this setting because you will want to Compile 
rather than Publish. 

This dialog can be called up from the publishing dialog when you come to it but the title must be 
established in advance. Illuminatus will prompt you for a title if you haven't set one.

Related Topics
Preferences
Publication Options



Installation Setup: Background
 select Installation Setup from the Publication menu in Publication View

This option allows you specify a colour scheme or graphic which will appear in the background of your 
setup program. Usually this is the familiar graduated blue-black background.

Illuminatus provides several colour schemes which you can select from the Fill Style drop down list. You 
can also create your own by clicking on the respective Palette buttons to choose a colour for the 
graduation to go From and another to go To.    

You can also insert bitmap graphics by clicking on the Image checkbox. Use the Browse button to locate 
the graphic you want to use. It could be a full screen promotional or welcome graphic or it could be a 
small reminder about something. If the image is smaller than the screen it will be centred over the 
background graduation chosen.

The preview box will show you what the background looks like at any time.

The program will automatically display the title of your publication in the topleft hand corner of the setup 
screen. You can disable this by editing the .ini for your publication in a text editor. Change the Show 
Text=Yes to Show Text=No to switch this off.



Installation Setup: Cover Dialog
 select Installation Setup from the Publication menu in Publication View

This is one of the special features of Illuminatus. It allows you to set the dialog which will be displayed 
while the program loads. This could be a simple copyright notice or it can be a full blown cover page for 
your publication. You could even export a copy of the first page of your publication using Export Page and
use that. 

You do not have to set a cover dialog in which case the default one will be used.



Installation Setup: Programs
This option allows you to specify any additional programs you want to distribute with your publication. This
does not need to include programs which you are launching directly if you have checked the Distribute 
Files option but    may include .DLLs and text files required by those programs. It can also include other 
multimedia publications you want to launch and or completely separate utility or support programs.

You can choose to set up any of these programs to install an icon with your publication to allow your user 
access to them or they can simply be distributed to be available to your publication.

Click the Add button to add a new entry to the list this puts the default title <new> into this list and then 
select it to edit is properties. You can then use the Browse button to locate the file you want to use which 
then appears alongside the Program: label. You edit the title for the program to suit by simply typing it into
the Title box which automatically replace the <new>. Titles and Filenames

If the program needs command line arguments or parameters, say if you want it to start up with a 
particular file then you can type these details into the Arguments box.

If you want to install an icon for this program click on the Install Icon checkbox and use the Browse button
to locate the icon you want.

You can remove a program you do not want to distribute by selecting its title in the list and clicking on the 
Delete button.



Installation Setup: Publication
 select Installation Setup from the Publication menu in Publication View

Title for Publication
You can select a title (you must have a title for the publication before it can be published). This title is 
used as your publications name under Windows - it is used under the icon and in the title bar of the 
publication's window. The title is not the same as the filename for your publication. It can be up to 25 
characters long and can contain spaces.

Default Directory
When a standard Setup program runs to install a program under Windows it usually has a directory where
it will be installed unless the user changes it. This option allows you to set that directory. It will be 
displayed by the setup program and your user can accept or change it as necessary. Usually you will 
want to put the directory in c:\ and give it a name related to its subject matter e.g: c:\catalog.

Note: We recommend you always install your publications into their own directories and in particular do 
not install your publication to the Windows directory. 

Icon
You can also choose an icon which will represent the publication in your user's Program Manager. Use 
the Browse button to locate and open the file you want.

Disk Size
You can also set the size of disk you will be publishing your publication on. This enables Illuminatus to 
calculate what size chunks to divide your publication into when it is being published. 

Click on one of the four options provided to select either 3.5" HD, 3.5"DD or 5.25"HD disks or CD Rom. 
This information is only used when you Publish your publication. The Compile function does not divide 
you publication into disk-sized chunks. Obviously the CD Rom option publishes everything into a single 
directory and doesn't break it up into chunks.

This dialog can be called up from the publishing dialog when you come to it but the title must be 
established in advance. Illuminatus will prompt you for a title if you haven't set one.

Related Topics
Preferences
Publication Options



Invisible
Allows you to make a button invisible but still functional so that it can be hidden under other buttons or 
graphics or text to act like a hotspot. If the button has a caption this will still appear in the editor but not in 
the finished publication which can be useful for reminding you of the button's function while editing.

Hotspots



Keyboard Shortcuts
The following keyboard shortcuts are available in Illuminatus.

New Publication Ctrl+N
Open Publication Ctrl+0
Save Publication Ctrl+S
Print  Ctrl+P

Exit Alt+X
Summary Info Ctrl+I

Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Paste In Original Position Alt+Ctrl+V
Delete Delete
Select All Ctrl+A

Edit Selected Object Enter
FirstPage Home
LastPage End
NextPage Page Up
PreviousPage Page Down

Preview F5
Compile F8
Publish F9

Switching between 
Page View 
and 
Publication View Enter



Last Page
 select Next Page from the Page menu.
End

Takes you to the last page in the current publication. 

You can use the End key as an shortcut/alternative.

You can also move to any page in your publication by selecting its title from the drop down list box in the 
toolbar in Page View.

Related Topics
Zoom 50%
Zoom 100%
Zoom To Fit
Next Page
Previous Page
First Page
Preview



Launch
This enables you to launch another program set up via the Launch tab. This checkbox on the Summary 
page lets you switch the set up Launch function on and off easily.

Button Options: Launch.

See also
Launching Other Programs



Launching Other Programs
Illuminatus allows you to program buttons to launch other programs. See Button Options: Launch for 
instructions.

An example of this would be to launch the Powerpoint Viewer program (PPTVIEW.EXE) and with the 
presentation you wanted it to view given in the With Parameter box.

This is the function which enables you to extend Illuminatus with ILX extensions. You launch your chosen 
extension which performs the additional function for you and then either simply drops back into your 
publication or relaunches your publication giving it a page number to jump to, as a parameter if required. 
Further Details Extension Programs

This also means it can be used as a front end for a compilation of programs or even a front end for a 
series of Illuminatus publications.

If the program you launch requires additional programs (text files, graphics or .DLLs) you need to 
distribute these files with your publication by adding them to the Programs section of the Installation 
Setup (Installation Setup: Programs)

Paths
In order for the Launch function to work it must have the right path to the program it will launch and this 
may well be different on your machine to your user's machine. Further guidance see Pathnames.

Copyright
Don't forget that to include these programs in your multimedia publication you must have a licence to do 
so or the program and associated files must be public domain.



Learning About Illuminatus
Of course the best way to learn about Illuminatus is to read the manual from cover to cover and then run 
the disk-based tutorial but most of you won't have the discipline for that so...

If you are an experienced computer-user the first step in learning to use Illuminatus is to read the Quick 
Start here or in the manual. Then explore the program and the samples before going back to the manual 
for further details and fine tuning your understanding as required.

If you are less experienced you should also read the Getting Started section of the manual.

About the Manual
The User Guide provides a stepped introduction to Illuminatus with Getting Started providing the basics, 
Getting Further provides additional material of use to most users once they are familiar with the program 
and then Getting Serious offers details of more advanced functionality.

About the Help
This online help provides all the additional information you may need providing a comprehensive 
reference for all the functions of the program as well as hints and tips, technical information and late-
breaking news. It also provides context-sensitive help from the various dialogs in the program.



Left
 select Align from the Edit menu in Page View

Selecting this option will align the lefthand edge of all selected items with the lefthand edge of 
the object furthest to the left.

Right
Top
Bottom
Centre Vertically
Centre Horizontally



Licences & Upgrades
Multimedia Clipart Licence 
The graphics and sound files which come with this program are copyright Digital Workshop and Words & 
Pictures. They can be used freely in commercial or non-commercial publications produced with 
Illuminatus but MAY NOT be distributed separately from the Illuminatus program or a multimedia 
publication created with it.

Additional User Licences
Additional licences for Illuminatus are available at discounts according to the number required. Special 
rates are available for educational licences.

Free Upgrades
Digital Workshop is committed to fair play on upgrades. Wherever possible    will have upgrades to fix 
bugs and upgrades to add features, not both. So you will only have to pay for new features. Upgrades to 
fix bugs will be free although a small handling and postage charge may be necessary for customers who 
do not have access to Compuserve or CIX where maintenance releases will be made available. Please 
note however that maintenance releases will only be available to registered users.



Loading Samples from CD Rom
If you are opening an Illuminatus .mpb file into the Illumintaus Editor from a CD the chances are that the 
publication was actually created on a different drive and so Illuminatus will look on that drive for the 
graphics, sound files, backgrounds etc. (Most people create their Illuminatus publications in a 
subdirectory of their C: drive and most people will have their CDRom as drive D: or E:) 

A special function in Illuminatus lets you know when this is happening and offers to help.

To tell Illuminatus to look for the resources on a different drive you can use the Change Data Drive option 
from Data Files on the File menu. Simply type the drive letter where the resources can be found into the 
box provided as in the example below.

If you continue to find that there are black pages and blank areas in your example use the Check Location
function, again from Data Files on the File menu to check the connection with each individual file.

Data Files



Location
This panel appears on the Summary page of both frame and button options. and allows you to edit the 
exact size and location of the object by editing the figures in the Top, Left, Width and Height boxes.

You can also alter the position of your object precisely by using the Nudge function.



Move
 select Move from the Edit menu in Page View

This option allows you to dictate the order in which frames and buttons will appear on the screen. Please 
note, however, that for technical reasons all frames are drawn first and all buttons drawn over the top. So 
ordering of frames is within the frame "layer" and ordering of buttons is confined within the button "layer".

To Front
To Back



Moving Images
Animations
Illuminatus supports the industry-standard .FLC and .FLI formats of animation. These are the native 
formats of the Autodesk range of animation products - Animator, Animator Pro and 3D Studio but they are 
supported by a wide range of other programs and utilities.

There are large numbers of such animations available on bulletin boards or from third parties and many 
companies can produce them to order.

Video
Illuminatus supports the Microsoft Video for Windows AVI format. There are an increasing number of 
video clips in this format available in collections from third parties. You can only play 

Slideshows
You can also create simple animations using the inbuilt slideshow function and several are provided free 
with the program. Slideshows

MPEG
This is a standard format for compressing, storing and replaying video and film material which achieves 
superb quality and compression but requires an MPEG video expansion card to be present to view the 
files.

Graphics
Sound
Text



Multiple Actions
There will be times when you want more than one action to take place from one button. Button options 
provide several actions which can be assigned on the same button, quite simply you can select any of the
items with a square checkbox (secondary actions) and one of the items with round radio buttons (primary 
actions).

To add multiple primary actions you can pile buttons on top of each other. When the user clicks on one 
they are all activated. This also allows you to create timers for events by using the Delay option to turn off 
the event started by the original button.

Because you can't select objects through each other you should make your lower frame/button larger 
than the one above it so that it can be easily selected. When you have finished your publication set the 
buttons to exactly the same size and shape if required.



Multiple Publications
Illuminatus allows you to have more than one publication open at one time. It will open a separate window
for each publication and you can move, resize and minimize these publication windows just like the main 
window though they always remain within their "parent" window. 

You can also use the Window option on the menu bar to close and reorganise your windows. Selecting 
Tile from this menu is very useful when you want to view two publications or pages together.

The number of publications you can have open at any one time will depend on the amount of memory, 
system resources and hard disk space you have available.

Having multiple publications open enables you to cut and paste pages between publications. This saves 
you recreating a page you have used in one publication and now want to use in another. Simply open 
both publications and select Tile from the Windows menu option. Click on the page you want to copy and 
click on the Copy button on the toolbar or select Copy from the Edit menu. Then click on the window of 
the publication you want to paste the page into and select Paste from the edit menu or click the Paste 
button on the toolbar. You cursor will change to show you are holding pages and you can paste them into 
your publication by clicking at whatever point you want them to go.



New Features
There are a great many changes and improvements in this version of Illuminatus. The following details 
some of the most significant ones.

OmniPalette option to avoid palette clash
Illuminatus now includes an OmniPalette option which banishes palette clash between the graphics in your 
publications simply by checking a checkbox when you compile or publish.

Built In Scrolling Text
Any frame can now be a scrolling text box and what's more it will be transparent so the background 
colour, picture or texture underneath it can show through. Text

Graphical Buttons
Buttons can now be assigned a graphic for up down and highlighted states. These graphics can be used 
transparently to create buttons any size or shape you want. Graphical Buttons

Transparency
Bitmaps can now be displayed transparently, allowing you irregular objects on screen without their 
backgrounds.
Graphical buttons can also have transparent areas and so be any shape you like.
Slideshows too can be transparent and so can now be played over backgrounds (great for moving mouse cursors 
and arrows around) and layered (ideal for building up animated maps and plan diagrams).

Improved Page Editing and Controls
Page editing functions have been extended to include Cut and Paste of buttons and frames and multiple Undo and 
Redo. There's also a nudge feature to move objects around a pixel at a time, you can centre objects and can move 
and resize multiple objects at once.    And button options now include Forward, Backward and Previous Page 
controls.

Slideshows, Videos and Animations can be replayed from CD Rom
Illuminatus will find the CD Rom so it doesn’t matter if it’s not D: drive. Great for producing slideshows of PhotoCD 
images. You can choose to slideshow all the files in a directory with a single option.

Publish to 16.7million colours, 800x600 and 1024x768
We’ve extended the program’s scope to cover 16.7million colours and to allow 800x600 and 1024x768 publications.

Customisable Setup Program with StartUp Graphic and even Faster Loading
Because of our modular feature design Illuminatus publications have always been quicker to load than many other 
publishing tools and now they’re even quicker. You can set a cover page which will appear in seconds. Plus the user 
has control over the buffering and compression of pages, installation of icons for supplementary programs, graphics 
for start up and setup program.

Custom Cursors
Specify special cursors to show when you’re over a button.

MPEG, PNG and PhotoCD support
Replay MPEG files fully-scalable in frames, incorporate Kodak PhotoCD images. Plus Illuminatus is one of the first 
commercial packages released to support the new PNG graphics format.

New Fades, Wipes and Effects with variable timing
A wide range of exciting and useful new effects including scrolling, zooms and fades for pages and slideshows all 
with variable speed.



Full CD Rom of Multimedia Resources and Publications
Illuminatus provides everything you need to make Multimedia publishing easy -even a CD Rom of resources, not just 
a collection of clipart but specially-designed multimedia dingbats, backgrounds, graphical buttons, copyright free 
music and sound effects and useful animations. Plus over 100 professionally-designed blank publications ready for 
you to use so you don't have to be a professional graphic designer to produce professional-looking multimedia.

Take some time to review these resources using the copy of Media Centre included with the program 
you'll be amazed at what's available.

Improvements
Faster Save and Compressed Save
Illuminatus now provides two ways of saving your publication    an ordinary Save and a compressed Save.
They are completely compatible and interchangeable, the only difference is that the compressed save 
takes longer but, obviously, saves disk space. We would suggest you use the standard Save function to 
periodically save your publication during editing and then use the Save Compressed when you have 
finished.

Faster Editing
The Illuminatus Editor has been speeded up considerably.

Optimised Distributable Files
Although there are many more features in this version of the program we have optimised the files required
for distribution to keep them to the minimum your particular publication requires so, for example, if you 
don't use Search, PhotoCD or animations the facilities for these functions are not distributed with your 
publication.

Special Effects
Special effects have been improved so they should perform at similar speeds on different computers.



New Publication
 select New Publication from the File menu.  
Ctrl+N

Creates a new, untitled publication without pages or page templates. You will be asked what size you 
would like the publication to be and can choose from 640x480, 800x600, 1024x768 by clicking on the 
appropriate radio button.



New Publication from Template
 select New Publication from Template from the File menu.

Opens a new publication from a skeleton version of a publication (Publication Template) which already 
contains the page templates necessary for the chosen publication. 



Next Page
 select Next Page from the Page menu.
PageDown

Takes you to the next page in the current publication. 

You can use the Page Down as an shortcut/alternative.

You can also move to any page in your publication by selecting its title from the drop down list box in the 
toolbar in Page View.

Related Topics
Zoom 50%
Zoom 100%
Zoom To Fit
Previous Page
First Page
Last Page
Preview



None
This option clears the other mutually-exclusive options and thereby allows you to use a button to play a 
sound, pop up a frame and/or stop an animation without performing anything else.

Button Options: Summary



Nudge 
You can now move your selected object(s) very precisely by "nudging" them one pixel at a time in any 
direction using the appropriate arrow keys. Thus...
...the Up Arrow key will move the selected objects up by one pixel.
...the Down Arrow key will move the selected objects down by one pixel.
...the Left Arrow key will move the selected objects left by one pixel.
...the Right Arrow key will move the selected objects right by one pixel.

This is an excellent way of lining objects up precisely or fine tuning their position.

You can nudge single objects or multiple objects. 



OmniPalette
This option is provided on the Compile and Publish dialogs and tells Illuminatus to use an optimised 
palette for all your graphics and therefore avoid palette clash. 
OmniPalette is specially designed to produce acceptable results on the widest range of illustrations but if 
your illustrations are all very similar and contain mostly similar colours the OmniPalette option may be too 
much of a compromise. In this instance you can optimise the palette manually.



Open Master Page
This is a special file dialog which allows you to select a Master Page to be loaded into your publication. 
Select the page by typing its name in the File Name: box or double-click on it in the list box below. The 
page must have previously been saved to disk using the Save As Master Page option. 

The page will contain all the frames and buttons which it was saved with, together with the graphics and 
other resources assuming the original files have not been deleted in the meantime. It is essentially 
identical to an ordinary page except that it is saved into a separate directory for ease of use and 
organisation.

The page you have chosen will be previewed in the box provided and you can load multiple copies of the 
same page by clicking on the multiple copies option and typing the number required into the box 
alongside.

This option is useful for reusing pages repeatedly in different publications and may be useful for specialist
pages like order forms or message boxes. 

About Master Pages



Open Page
This is a standard Open File dialog which allows you to select a specific page to be loaded into your 
publication. Select the page by using the drive and directory list boxes to find the file you want and then 
type its name in the File Name: box or double-click on it in the list box below. The page must have 
previously been saved to disk using the Save Page As option. Saved pages have the extension .pge. 

The page will contain all the frames and buttons which it was saved with, together with the graphics and 
other resources assuming the original files have not been deleted in the meantime.

You can also open Master Pages using this option. These are simply pages stored in a special directory.

The page you have chosen will be previewed in the box provided and you can load multiple copies of the 
same page by clicking on the multiple copies option and typing the number required into the box 
alongside.

This option is useful for reusing pages repeatedly in different publications and may be useful for specialist
pages like order forms or message boxes. 



Open Page Template
This is a standard Open File dialog which allows you to select a skeleton page or page template by using 
the drive and directory list boxes to find the file you want and then type its Title in the Title box or double-
click on it in the list box below. The template you have selected is previewed in the box to the right.

Page Templates are pages of frames and button without any contents. They are arranged in various 
styles which you can select using the List files of type box at the bottom of the dialog. See About 
Templates.

A multiple copies option is provided for you to Open more than one page template a at a time. Simply type
the number required into the box provided and when you click on the Publication Window to paste the 
pages in Illuminatus will insert as many copies of the page template as you have requested. 

Page templates have the extension .pgt.

If you want to open some of the sample ready-made publications provided with Illuminatus you should 
use the ordinary Open command from the file menu.



Open Publication
 select Open from the File menu. 
 Ctrl+O

Opens a publication previously saved to disk. A standard Windows Open dialog allows you to browse your
system for the file required. Use the drive and directory list boxes to find the location for the file and then 
type the name in the Filename box or click on the filename in the list box below.



Open Publication Template
This is a standard Open File dialog which allows you to select a publication template by using the drive 
and directory list boxes to find the file you want and then type its name in the File Name: box or double-
click on it in the list box below.

Publication Templates are collection of Page Templates. See About Templates.

Publication Templates have the file extension .mpt.

If you want to open some of the sample ready-made publications provided with Illuminatus you should 
use the ordinary Open command from the file menu.



Ordering Information
Select Print Topic from the File menu to Print this Order Form.

ILLUMINATUS - Order Form 
Also available directly in the following countires USA, Australia, France, Germany.

Yes. Please rush me the full version with free CD-Rom, manual and lifetime support.
Name:................................................................................................................
Organisation:.....................................................................................................
Address:............................................................................................................
...........................................................................................................................
...........................................................................................................................
Country....................................................PostCode:.........................................
Telephone................................................Fax....................................................

Illuminatus v3.00
........ copies at the special price of £129.95    = ...........................
Illuminatus SuperPack
........ copies at the special price of £179.95    = ...........................
plus postage and handling £5.00    =............................
Vat @ 17.5% (UK residents only) =............................
Total =............................

__ Please charge my credit card: Access/Visa/Mastercard/American Express
Card No:.......................................................................... Expiry Date.................

Signed..................................................................................................................
__I enclose a cheque/postal order/Eurocheque.

Sales Hotline: 01295 258335 (or outside UK: +44 1295 258335)
Sales Fax: 01295 254590 (or outside UK: +44 1295 254590)
Email: sales@digitalworkshop.co.uk
Compuserve: [74431,1160]
Cix: theworkshop

Postal Address:
Digital Workshop
19 Parsons Street, 
Banbury, 
Oxon, 
OX16 8LY UK



Ordering Information (US)
ILLUMINATUS - Order Form (US and Canada)
Also available via UK, Australia, France, Germany.

Yes. Please rush me the full version with free CD-Rom, manual and lifetime support.

Name:................................................................................................................
Company:..........................................................................................................
Address:............................................................................................................
...........................................................................................................................
...........................................................................................................................
Country.....................................................ZipCode:...........................................
Telephone:................................................Fax:..................................................

Illuminatus v3.00
........ copies at the special price of $169 = ...........................
plus shipping and handling $5 =............................
(airmail outside North America $16 = ......................... )
sales tax 6.5% (Minnesota residents only) =............................
Total =............................

__ Please charge my credit card: Visa/Mastercard
Card No:......................................................................................Exp.................

Signed..................................................................................................................
__I enclose a check made payable to JASC Inc

Sales Hotline: 1-800-622-2793      Voice: 1-612-930-9171      Fax: 1-612-930-9172

Compuserve:74774,570

Postal Address:
JASC, Inc, PO Box 44997, Eden Prairie, MN 55344, USA



Page
This menu provides control over how your page is displayed.

Zoom 50%
Zoom 100%
Zoom To Fit
Next Page
Previous Page
First Page
Last Page
Preview



Page Options
Double click anywhere empty portion on the background of a page or on the pasteboard outside it to bring
up the set of Page Options dialog.

Click on the tab for further details on that aspect



Page Options: Background
You can add a background colour to your page. Clicking on the Palette button brings up a standard 
Windows colour-selection dialog from which you can choose any of the ready-made colours or create 
your own by clicking on the Define Custom Colours button.

Note: This colour is the colour used to surround your publication if a publication is run in a graphics mode
larger than it was designed for e.g: a 640x480 publication in 800x600 mode. It is also used for the blank 
screen between pages so it can be important to set this colour even if a picture normally fills the 
background of your page.

You can also load a picture in any of the supported graphics formats by using the file list boxes at the 
bottom of the dialog to find it on your disk. Checking the Scale to Fit option will resize the picture to fill the 
background, with the Keep Aspect option checked the picture will not be stretched out of proportion in 
order to make it fit. The scale to fit option is not relevant for vector format pictures such as .WMF.

The background picture can be a texture, an illustration or a graphic which designs the publication in a 
certain way. It can also be Transparent in which case a chosen colour in the picture will be ignored and 
the background will show through. You can set this colour by clicking the Set Colour button and choosing 
from the palette which comes up.



Page Options: Display
This option allows you to choose a special effect with which your page will appear on screen or disappear.
Simply select the effect you want from the appropriate drop down list for either Page On Effect or Page 
Off Effect. The effect will be automatically previewed in the box to the right and you can test either of the 
effects again by clicking on the Test On or Test Off buttons.

Using the Over Existing Page option (recommended) you can specify whether the page should appear 
over the preceding page over whether it should go to a blank screen first (the colour of this blank screen 
is set by the background colour setting on the Background dialog).

The Cut effect is equivalent to no effect at all. You have an on or off effect or both and they can be 
different.

You can set the speed of the effect using the Speed scrollbar, the higher the number the faster the effect.

Note: The speed of the effect may not be accurately previewed in the preview box. Some effects may be 
unsuitable for use with full pages on slower machines.



Page Options: Sound
A page can also play a piece of music or sound effect. You can set this up via the Sound tab. Use the file 
list boxes to find the file you want to play. You can listen to the file pressing the Audition button. A Clear 
button is provided to remove any existing file details if necessary.

Selecting Loop will play the file repeatedly. 

Delay enables you to synchronise the sound with another event or time it for some other reason.

Stop Existing Sound will stop any background music playing but please note that two files of the same 
type cannot be played at the same time anyway so this is only relevant if you are playing a midi track and 
want to launch a WAV file or vice versa. 

You can ensure that the sound does not continue when you move onto the next page by checking the 
Stop on Next Page option. To provide background music for your entire publication simply start a sound 
on the first page without checking this option and the music will continue until another button or page 
stops it.



Page Options: Summary
The summary allows you to switch the various other options on and off conveniently. It also allows you to 
make the page display for a specified length of time by clicking on the Timed checkbox and typing the 
time in seconds or tenths of seconds in the box provided. 

This can create a rolling presentation which displays your pages without any interaction from the user or 
can be used with interactive pages to ensure the page moves on if the user doesn't press a button first.

Timed Page



Page View
Page View shows your publication one page at a time so that you can see the various page elements to 
edit them. 

Moving Around Your Publication
You can work on your entire publication in Page View by moving backwards and forwards through the 
project using the slideshow buttons provided or Home (to jump to the first page) and End (to get to the 
last page).

You can also jump to any chosen page simply by selecting its title from the drop down list of page titles in 
the toolbar.

Zoom
Page View allows three levels of zoom - Zoom 100% (for previewing the page exactly as it will appear), 
Zoom 50% (so you can see the whole page with reasonable detail) and Zoom to Fit (scales the page to fit
the whole page into the current window). 

Most users will find it most convenient to use Zoom to Fit with both Illuminatus and the publication window
maximised

The Page Elements
An Illuminatus page consists of three elements...

Page - Certain elements and functions can be applied to the whole page. You can display it for a 
specific length of time, select a special effect with which it will appear and/or disappear and play 
background music or sound. The background of a page can be coloured and/or can contain a graphic 
which is either an illustration or an attractive pattern or which imposes a design on the publication.

Frames - these are the boxes into which text, graphics, animations and/or slideshows can be 
loaded. They can have a background colour or can be transparent (select the background colour None). 
They can have a selection of different border types.

Buttons - these control the actions of an Illuminatus publication. Unlike standard buttons they 
can have multiple line captions. They can also be invisible which enables them to be used as hotspots as 
they are not visible but can still perform the action assigned to them and so can be placed under a 
graphic so that when the user clicks on the graphic he/she is clicking on the invisible button. 

Editing the Page Elements

This is a comprehensive list of the commands available in Page View. Simply click on one for further 
information on the function.

File Menu
Save...

Save Publication
Save All Publications
Save Publication As
Save Page As
Save As Master Page
Save Page As Template

Export Page
Print
Printer Setup
Return to Publication View



Edit Menu
Add

Frame
Button

Delete
Move

To Front
To Back

Align
Left
Right
Top
Bottom

Page Menu
Zoom 50%
Zoom 100%
Zoom To Fit
Next Page
Previous Page
First Page
Last Page
Preview

Tools
Picture Editor
Word Processor
Sound Editor
Setup Tools

Window

Help

Related Topics
Preview
About Master Pages



Palette Clash
Palette clash is the appearance of strange colours or on images particularly when you change pages, 
when going through a slideshow or when launching a video or animation when running in 256colour 
mode.
This is due to the fact that any one 256 colour graphic will use all the 256 colours available. Displaying a 
second one which uses a different 256 colours will mean there aren't enough colours in the palette to do 
both. Windows will use the palette of the current picture and will automatically change to suit that picture. 
But in doing so the new palette will be momentarily imposed on the old image or Windows will use the 
closest colours for both and its colours will change, with often very psychedelic and unwanted results.

Illuminatus provides a special option which can solve the problem when you Publish or Compile your 
publication called OmniPalette.

Palette clashes can also occur when launching a video clip or animation.

The solution is to ensure that all your pictures have the same palette; that is, use the same 256 colours in 
the same position in their palette. To do this you will need a paint program or graphics utility such as 
Paintshop Pro.

Creating a Custom Optimal Palette.
To create a palette to avoid clashes it needs to contain the most useful colours from all the graphics. The 
best way to do this is to find areas in each picture which contain the most colours and cut the area out 
and paste it into a blank picture created in 16.7 million colour mode. Repeat this with every picture in the 
publication to build a mosaic of all the colours required. Then you should reduce this mosaic to 256 
colours using the "optimal" palette option and Error Diffusion colour reduction method if these are 
available. Save the palette file and then finally, load that palette onto all your original pictures again using 
the Error Diffusion method if available.

Animation and Video
Palette clashes can also occur with animation and video and this is more difficult to avoid. If you are using
only one movie the easy way is to get the palette from that and apply it to all your images. If you are using
more than one video you could break the animation or video down into graphics of each frame using a 
program like Video Toolbox and then prepare a compromise palette in a similar way to that described 
above. Apply this compromise palette to all your animations/video and images.
If you have a lot of graphics in your publication you can reduce the amount of work this requires by 
optimising palettes only for pictures which are used together.

The only way to avoid palette clash entirely is to produce your publication in 16 colours or 16.7 million 
colours.



Paste (Page View)
 select Paste from the Edit menu 
 Ctrl + V

Pastes any buttons and/or frames currently stored on the Clipboard. All the contents and attributes are 
retained. The items will be pasted slightly down and to the right of their original position.

You can change move onto another page before pasting thus allowing you to transfer items between 
pages.

Related Topics
Paste in Original Position
Cut
Copy



Paste (Publication View)
 select Paste from the Edit menu 
 Ctrl + V

Pastes any pages currently stored on the Clipboard. The cursor will change to the one illustrated below to
show that you have pages to paste. The contents of pages are copied with the page and a number is 
added to the page title to differentiate it from the original. You can subsequently edit the page title to suit.

Related Topics
Cut
Copy



Paste in Original Position
 select Paste in Original Position from the Edit menu 
 Ctrl +Alt+ V

As the name suggests, this function allows you to paste the clipboard objects back in the same position 
on the page as they were cut or copies from. This can be particularly useful for creating piles of buttons 
for multiple actions and for pasting the same objects in the same place on several different pages.

Paste
Cut
Copy



Pathnames
When launching additional programs or using them as parameters, or when writing or reading to and from
text files using the report text and load text features Illuminatus will need to know where to look for these 
files. This is called the pathname for the program and will probably be different for publications in the 
editor and when they are published. 

The best way round this is to use your computer's path during editing and Previewing and then change 
the pathname by typing it into the Launch this Program and With Parameter boxes according to the 
considerations below

If you are launching another application which you are guessing your user will have and you can guess 
where it might be you type in the full specific pathname. An example would be the Windows Calculator 
which you can be pretty confident will be in the Windows directory as calc.exe. You can therefore type c:\
windows\calc.exe in the Launch this Program box. To catch users who have installed Windows on a 
different drive rather than C: you use \windows\calc.exe instead which will look for the Windows directory 
on whatever drive the program is currently being used.

Distributed Files
If you are distributing the file with your publication you only need include the program name and leave the 
pathname off altogether irrespective of where it is on your machine as Illuminatus will install it into the 
same directory as your publication when you publish your publication and so will find it there.

Relative Paths
You can tell your publication to look for the file in a subdirectory of wherever it is installed by typing a 
single full stop, a backslash and then the subdirectory e.g .\images\mypic.pcx could be used as a With 
Parameter command for ILMPIC to tell it load a picture from the images directory below the publication 
and it wouldn't matter where the publication had been installed.

Writing to Text Files
If you are using a text file to report text you will need to know exactly where that is so you will need to 
ensure the pathname is right. If you just specify the filename without a path it will be written into the 
current directory which will make it easier to find. But note that if your are distributing a publication which 
runs from CD rom you will not be able to write to that directory as the CD is read only. You may therefore 
want to specifically report text to C:\ to be more confident that it will be written.
However, if you are reporting text to disk to be displayed again in a scrolling text box this must be done in 
the publication's directory and so no pathname should be included for the Reoprt Text file.



Photo CD Slideshow
You can create a slideshow of pictures direct from a Kodak PhotoCD disk by using the From CD option on
the slideshow section of the Frame Options dialog. Please note, however, that PhotoCD images are high 
colour images and will not display properly in 16 or 256 colour modes. If you want to display PhotoCD 
images in these modes do not use the From CD option and Illuminatus will incorporate them the 
publication and optimise their appearance for whatever colour mode you are compiling or publising to.



Picture Editor
This option allows you to launch your favourite paint program to create or edit graphics without leaving 
Illuminatus. When you have finished editing or creating the picture save it to disk ready for use in 
Illuminatus. 

You can save it in any of the formats supported by Illuminatus. 

If you edit a file you are already using in Illuminatus the copy in your publication will be automatically 
updated.

Related Topics
Graphics
Setup Tools



Play Sound
This item on the Summary of the Button Options dialog instructs the button to play a sound file as set up 
via the Button Options: Sound tab.

Sound & Music
Sound Editor



PopUp Frame Option
This checkbox on the Frame Option: Summary is the option which tells Illuminatus to treat your frame as 
a popup frame. If you switch this on Illuminatus will automatically create a title for the frame if you haven't 
already done so as without a title the frame is not visible when you come to use the Button Options to 
Show Frame or Hide Frame.

PopUp Frames



PopUp Frames
You can now set Illuminatus frames to appear on command. These are called popup frames. They are 
displayed by buttons set to Show Frame and can be hidden again by buttons programmed to Hide Frame.

There is no need to hide popup frames before leaving a page as they are automatically closed when the 
publication moves on. 

Popup frames can contain any of the elements in a standard frame the difference being that they will not 
be visible until a button is used to display it. The transparency option cannot be used with popup frames. 
If you want irregularly-shaped pop up frames you should create the background manually or using Export 
Page or you can use slideshows.

These are obviously useful for displaying further information on demand, displaying a related picture or a 
definition of a particular term and so on.

To create popup frames which display for a particular length of time see Step-by-Step Timer



Preferences
 select Preferences from the File menu 

Allows you to control several aspects of the way Illuminatus works.

Make Backups When Saving - Whenever you save a publication Illuminatus can keep a backup of the 
previous version for you to revert to if necessary. The backup is stored in the same directory and filename
as the original but has the .bak ending. You can revert to this version by renaming it to [filename.mpb].

Thumbnails in Publication View - Creates a miniature image of your page and displays this in 
Publication View in place of the standard page icon. It can slow the program down on slower machines.

Show Bitmaps While Editing - Allows you to hide the graphics on your page while you are editing it in 
Page View and so speed up operation of the program. The pictures will still display in Preview.

Show Start Up Dialog - Allows you to launch Illuminatus straight into publication view without the 
prompts on the title page.

Help Tag Colour - Allows you to choose your own colour for the help tags which appear over the toolbar 
to prompt you of the use for the button.

Background Music - Allows you to play background music while you work in Illuminatus. Obviously this 
music stops while you preview your publication.

Initial Zoom - Allows you to specify the zoom setting which Illuminatus will start in when it switches to 
Page View. You can select any of the options available as your default or the program can remember the 
last zoom used.



Preview
 select Preview from the Publication or Page menu.  
F5

This function allows you to preview your publication. It runs the publication as it will be displayed on your 
reader's machine and allows you to view the design and test buttons and so on.

You can run Preview from both Publication View and Page View by pressing F5. 

Please note: Preview is still referring to the original files to create your publication and so is considerably 
slower than the final version will be. This is particularly true if you are using large compressed graphics 
such as jpg and PhotoCD as these take time to process during preview but not in the finished publication. 
To accurately preview the speed of your publication you should compile it and run that version outside the
editor. 

Most .ILX extensions cannot be tested in Preview mode and simply will not work as they need a finished 
publication to refer to. Again you should compile your publication and test that.



Previous Page
 select Next Page from the Page menu.
PageUp

Takes you to the preceding page in the current publication. 

You can use the Page Up key as an shortcut/alternative.

You can also move to any page in your publication by selecting its title from the drop down list box in the 
toolbar in Page View.

Related Topics
Zoom 50%
Zoom 100%
Zoom To Fit
Next Page
First Page
Last Page
Preview



Print (Page View)
 select Print from the File menu in Page View
Ctrl+P

Prints a preview version of the current page to the current Windows printer. For printers using A4 paper 
the output will look best if the printer is setup in landscape mode.

Printing
Print (Publication View)



Print (Publication View)
 select Print from the File menu in Publication View
Ctrl+P

Prints your whole publication or a range of pages from your publication, one page per printed page, to the
current Windows printer. For printers using A4 paper the output will look best if the printer is setup in 
landscape mode.

Printing
Print (Page View)



Print Page
This option on the Summary section of Button Options dialog lets you tell a button to print a copy of the 
current page. Please note that this process prints a graphic of the page and may therefore take time to 
print. You may therefore prefer to use the Print File option available to print a text file.



Printer Setup
 select Printer Setup from the File menu in Publication View

Allows access to the standard Windows Printer Setup dialog to control your printing options. For printers 
using A4 paper output from Illuminatus will look best if the printer is setup in landscape mode.

Print (Page View)
Print (Publication View)



Printing
You have now two ways in which your publication can print material. You can instruct a button to print a 
graphic of the current page by selecting the Print Page option. Or you can print a text file by using the 
Print File option on Button Options: Report

In both cases these functions will print to the default Windows printer.



Publication
This menu provides the tools of building and publishing your publication.

Publication Options
Installation Setup
Insert Blank Page
Insert Page Template
Insert Page
Insert Master Page
Compile
Publish
Preview



Publication Directory
The dialog which comes up when you click on Browse Directories from the Compile or Publish dialog 
allows you to locate an existing directory into which your publication will be Compiled or Published. 
Simply use the drive list box to select the relevant drive (if necessary) and then select the directory where 
you want the publication built.

Note: We strongly recommend that you create your compiled or published version in a separate directory.
In particular publishing to a directory which already contains files will cause those files to be included in 
you publication causing, at the very least, wasted disk space.

Compile
Publish



Publication Options
 select Publication Options from the Publication menu

This set of dialogs lets you set up options which apply across the whole publication.

Click on the item you want further details on.

Related Topics
Preferences
Installation Setup



Publication Options: Closedown
 select Publication Options from the Publication menu

The Publication Options allow you to set up options which will apply across the whole publication.

Closedown is the overall term for the way your multimedia will close when it is Exited or when the user 
closes it using a button you have provided for the purpose by checking the closedown option. 

You can play a sound file or piece of music by clicking the Play Sound checkbox. Find the file you want 
using the Browse button and try it using the Audition button. 

You can also display an end page by selecting it from the dropdown list of those available in the 
publication and then clicking on the Show Page checkbox. You can set how long it will be displayed for by
typing the number of seconds in the For box provided.

A typical use for the end page would be a copyright notice, a thank you or a reminder of how to order or 
who to contact for further details.

Note: Do not include a button programmed to go to Closedown as you closedown page or you will lock 
your publication into a loop. Closedown pages should always be timed pages either by setting the Timed 
option in Page Options or by typing a display period here.



Publication Options: Cursors
The Publication Options allow you to set up options which will apply across the whole publication.

You can now set special cursors for your publication to use. A number are provided with Illuminatus or you
can create your own if you have access to a resource editor such as those which comes with 
programming languages.

There are three states you can set cursors for
Normal 
This is the cursor which will simply indicate the position of the mouse pointer when the others are not 
used.
Busy 
This is used when the system is doing something and is usually the familiar egg timer cursor.
Select
This cursor is used when there is something to be clicked on. 

Use the appropriate Browse button to find a cursor for each type as appropriate. If you don't select one 
for a particular state the default Windows one will be used. The default Windows cursors are also 
supplied with Illuminatus so you can reset to the defaults by loading these in in place of your custom 
ones. The default Select and Normal cursor is included as arrow1.cur and the default busy cursor is 
provided as busy.cur.

Ordinarily under Windows both Select and Normal are the same arrow shape but they are separated here
to allow you to have special cursors to signify when there is a hotspot or hidden button on the page so 
users do not miss buttons which do not look like buttons.



Publication Options: Exit
The Publication Options allow you to set up options which will apply across the whole publication.

This option sets how users can exit from you publication without pressing a button which has been 
programmed to close the publication using the Closedown option.

You can select the Esc and/or Alt+F4 as keystrokes to interrupt and close the publication by clicking on 
the box(es) as appropriate.

There are several circumstances under which you might also want to ensure that no unauthorised people 
could interrupt your publication and Illuminatus allows you to protect the exit of your publication via a 
password which you can set and update by simply typing the required password into the Password box 
provided.

Note: The Password option does not prevent users closing a publication using an exit button programmed
with the Closedown option. You will need to create this option specially if this the effect you want to 
achieve.



Publication Options: General
The Publication Options allow you to set up options which will apply across the whole publication.

Reset
Allows you to set up the time your publication waits before automatically resetting itself. Further Details.

Default Transparent Colour
This allows you to set up the colour which will be used for making graphics transparent unless you 
change it for particular graphics in the places provided. Further Details.



Publication View
Publication View is an overview of your entire publication showing all the pages in it. 
If you have no pages in your publication the screen will look like this.

You can add pages by clicking on the Insert New Page button on the toolbar and then clicking on your 
publication window.

Each page is represented by a miniature representation of the actual page (or an icon if Preview 
Thumbnails is off) and a title. You edit the title by typing it into the box provided on the toolbar in Page 
View.

To edit a page simply double click on it in Publication View. If the page is already selected you can simply 
press Enter.

You can switch backwards and forwards between Page View and Publication View by pressing F4.

Here is a list of the commands available in Publication View. Simply click on any of them for further 
information on their function

File
New...

New Publication
New Publication from Template

Open Publication
Save...

Save Publication
Save Publication As
Save All Publications
Save Publication As Template

Close Publication
Data Files

Check Location
Change Data Drive
Consolidate Project

Print
Printer Setup
Summary Info
Preferences
Exit

Edit
Cut
Copy
Paste
Delete
Select All
Deselect All
Edit Selected Page

Publication
Publication Options
Installation Setup
Insert Blank Page
Insert Page Template



Insert Page
Insert Master Page
Compile
Publish
Preview

Tools
Picture Editor
Word Processor
Sound Editor
Setup Tools

Window

Help

Further Information 
Selecting and Moving Pages
Multiple Publications
About Templates

Related Topics
Preferences
Installation Setup
Publication Options
Preview
Page View



Publish
This option allows you to produce an independent multimedia publication for distribution to other 
computer users. It gathers all the files you have used together, allows you to add others if you wish and 
then bundles everything together, compresses it all and writes a setup program to install it on your 
reader's computer.

Although the published version of the program is intended for distribution on floppy disk you should 
publish it onto your hard disk. and then copy it to the floppy using File Manager. This is much faster and 
means you have a reference copy of the publication on your disk.

Disk1, Disk2 Subdirectories
The Publish operation will break the complete publication into pieces of the correct size for the disk you 
are publishing it for. It then places each of these sections into a separate subdirectory in the directory you 
chose so that they are easily separated. These subdirectories are called disk1, disk2 etc. To copy your 
publication to floppy simply copy the files contained in these subdirectories to the first, second, third 
floppy disk of your publication as required.

Larger Than Floppy Publications
If you want a publication to fit on a removable hard disk, an optical drive, tape drive or other medium with 
larger capacity than the floppy options provided you can either Compile it and then copy the working 
version to the large capacity media or you can Publish the publication to 1.44Mb floppies and simply copy
all the resulting data files to the same location on the large capacity media. The setup program will ask for
disk2, disk3, etc but you can simply press Enter as the data files will be there already.

What You Need To Do Before Publishing
If you have not saved your publication you will need to do so. You will also need to give your multimedia 
publication a title before you Compile or Publish it. This is not the same as the filename for the publication
it is the title used in the menu bar and is required by Illuminatus to set up the data for your publication. 
Illuminatus will remind you about these two requirements if you try to publish or compile without them. 
(See Installation Setupfor further details.)

Step-by-Step Publish

Related Topics
Compile
Installation Setup
Publication Options



Quick Start
The Welcome Screen of Illuminatus allows you to go straight to where you want to begin work. Simply 
click on the button for the starting place you require...

 will open a File Open dialog to let you open an existing publication or to load a sample or tutorial file.

 will open a New and entirely blank publication.

 will open a skeleton publication known as a Publication Template.

 (at the bottom of the dialog) will open the last file you used which is given in the box alongside.

If you are starting a New publication you are asked what size you want it to be. Choose from 640x480 
(standard VGA), 800x600(Super VGA) or 1024x768 by clicking the appropriate radio button.

The Illuminatus Editor starts up in Publication View    in which the main editor window contains a 
publication window within it which provides an overview of your publication with all the pages displayed as
icons or thumbnails. For a new publication it will be empty and waiting for you to add pages.

You can build your publication from any combination of pages and page templates which you can insert 
from those options on the Publication Menu or using the relevant buttons on the toolbar. You then click in 
your publication window at the point where you want the pages inserted. You can insert blank pages and 
draw in the frames and buttons you need or choose from a wide selection of skeleton pages (page 
templates) is provided for you if you prefer.

Double click on any page to edit it. This takes you into Page View where each page of your publication is 



displayed as a rectangle (or part of it depending on the size of your screen and your Zoom setting)

Double click on the background to edit the basics of the page, its colour or background picture, to attach a
sound or music, to display it with a special effect or for a certain length of time.
Page Options

To add frames or buttons select Add|Frame or Add|Button from the Edit menu or click the appropriate 
button on the toolbar. Click on your page where you want the top left corner of your frame or button and 
then drag down and right to create the object.

To reposition a frame or button simply drag it to where you want it to be. To reshape and resize a button 
or frame drag one of the eight handles which appear around it when selected to create the shape 
required.
Editing Page Elements

Double click on a frame to load its contents, colour, picture, animation, slideshow, text etc, to alter its 
precise size and location and its border style. 
Frame Options

Double click on a button to give it a caption and connect it to an event (launching a video, slideshow, 
animation or moving to another page, etc.) and to alter its precise size and location.
Button Options

Preview the complete document using the Preview button.
Preview

Save your publication to disk using Save Publication As from the Save submenu of the File menu or use 
Consolidate Project to save your publication and copy all the files it needs into the same directory for 
convenience.

Once you have completed your document you can produce an independent program by compiling it on to 
your hard disk or publishing it onto floppy disks (from the Publication menu). Set your Installation Setup 
and Publication Options to specify a title for your publication and the details to build it into a distributable 
form. You can choose an icon for your publication and create it in mono, sixteen, 256 or 16.7million 
colours and Illuminatus will handle any colour changes automatically.
Compile
Publish

NOW READ
About Colour Modes
Important Considerations



Read This First
New Features Added Since the Manual Went to Press...
Nudge
Illuminatus now includes a nudge function which allows you to move selected objects one pixel at a time 
in any direction using the arrow keys.

Centre Alignment
There are now two new commands on the Align menu... Centre Vertically and Centre Horizontally for cent
ring selected objects above or alongside each other.

Graphical Button - Clear
There is now a Clear button on the Graphical button dialog which enables you to remove any graphics 
from the three button states. Simply select the button state you want cleared and press the clear button.

Enter to Edit
You can hit the Enter key to bring up the Frame Options or Button Options dialogs when you have the 
appropriate object selected.

Change Graphics File Extension
This is enables you to tell Illuminatus to look for different format files to the ones originally loaded into the 
publication. (See Change Graphics File Extension for further details.)

Scrolling Text Boxes
Scrolling text boxes can now be used to display scores and information from the user. They only display 
scrollbars if required so single line text can be displayed without scrollbars. This enables you to display 
output from Report Text or the ILMScore.ILX in the publication itself. Please note, however, that that the 
scrolling text boxes look for their text in the publication directory only so the files you want to read should 
have not pathnames associated with them. This also means that this will not work with publications being 
run from CD-Rom. Also note that because of text spacing settings both in Illuminatus and some True Type
font definitions the size of frame a single line needs before it does not require scrollbars is considerable.

Compile Copies Additional Programs
Compile nows copies any files listed in the Programs section of the Installation Setup.You can use this to 
copy across any data or text files your program needs. The sample publications provided on the 
Illuminatus CD illustrate this point.

Technical Update
Disk Space
The most frequent cause of problems with Illuminatus is users running out of disk space while Illuminatus 
is in the middle of something. If you experience problems with Illuminatus check your disk space and 
other system resources and try again. 
This is particularly true when Compiling and Publishing. For this reason we have introduced some 
messages to warn you if you are getting low on disk space. Please note that this is only a warning and 
small publications may still fit into the space you have available. You will also be told if the 
Compile/Publish failed to complete properly but the advance warning, we hope will help stop the 
frustration of compiling a large publication only to find it has failed because of lack of disk space.

Save Compressed
Publications saved in compressed form using Save Compressed can still be opened and edited in 
Illuminatus without being decompressed they just take longer to open.

Selecting Objects
You cannot select objects through other objects. You must bring the object to the front, if necessary by 
sending the other object to the back. This is also true of the editing handles relating to objects so beware 



of this when trying to edit objects immediately alongside each other as they do not look as though they 
overlap but their editing handles may be "underneath" the neighbouring object and will not be selected.

Deselecting Objects
You cannot deselect individual objects in a group by Shift+clicking on them again. You must cancel the 
selection and start again.

Moving Multiple Objects
To move multiple objects keep Shift pressed down while you drag the objects but note that only the 
outline of one object will be drawn while you're moving. When you release the mouse button all the 
objects you have selected will be redrawn in the new positions.

You can select, resize and move more than one object at a time. Working with Multiple Objects.

PopUp Frames
Transaprency does not work in pop up frames. To recreate the effect use export page and crop out a 
graphic for the background of your frame.

Editing Page Titles
Please note that you must press the Tick button to record any changes you make to the Page Title. 
Pressing Enter or clicking elsewhere will leave the new Page Title in place only for as long as you stay on 
that page and will not be stored until you press the tick.

Page Templates in Publications over 640x480
All the page templates provided with the program are designed for use at 640x480 as the lowest common
denominator. You can, of course, resize them to higher resolutions using the resize multiple objects 

OmniPalette
OmniPalette only works in compiled or published publications, it does not improve the quality of Preview 
nor will it work on images which are accessed directly from CD at runtime using the From CD option.

Preview Limitations
The speed and graphics quality of Preview of your publication in the Illuminatus editor can vary quite 
considerably from the final publication if you are using compressed graphics files (e.g JPG) or if you are 
using 16million colour graphics (e.g:PhotoCD) in 256 colour mode and such like. We recommend you 
compile your publication to test it properly.

Almost all the extension programs supplied with Illuminatus require a compiled or published publication to
function so will fail if used during Preview.

Drive List Boxes
The drive list boxes at the bottom of some sections of the frame option and button option dialogs 
sometime confuse the user because the file and pathname for the file used in that section may be 
different to the path the list boxes are actually displaying. If this confuses you as to what the list boxes are
showing simply refresh the information by changing the List Files of Type or changing the directory until 
you can establish where you are.

Recommended SetUp
For ease of use we recommend that you run Illuminatus in 64k or 16.7million colour graphics mode for the
majority of the time. The best resolution is 800x600 which allows you to work on (almost) a whole 
640x480 page at 100% zoom. Maximise the Illuminatus Editor window and your publication window within
that and view your page at 100%.
Then compile or publish down to 256 or 16 colours using the OmniPalette option for the former. You can 
then change down to 256 colour mode and/or 640x480 to test your publication and work on tidying any 
remaining display-related problems. About Colour Modes



Printing Limitations
The Illuminatus printing option is intended primarily for text output and black and white images and may 
not produce acceptable results with colour images or colour printers. If you wish to provide printout of 
product information etc create an optimised black and white image using Paintshop Pro and print this.

Technical Information...
Keyboard Support
Please note that Illuminatus requires a mouse throughout. This is augmented by keyboard shortcuts such 
Ctrl+V (for Paste) and F5 for Preview. The program does not provide full keyboard support for dialog 
options.

Palettes
If you are publishing to 256colours and are not using OmniPalette you should ensure that the background
of your page or the first graphical frame has the palette you want to use. If this image has limited colours 
fill the spaces up with colours used in other pictures for better results. If you have optimised your palettes 
manually this probably won't be necessary.

Related Information
Important Considerations
Other Hints and Tips



Recreating Standard Presentation Effects
Illuminatus can produce a presentation similar in style to standard presentation packages by using timed 
pages displayed with special effects and slideshows for all the elements of a "slide". Slideshows can 
consist of only one picture and so (with the Delay option) allow for timed display of elements on your 
page. If you want to use text in this way you should convert your text to graphics as follows.

Load a template or create a page for a bulleted list. Load a background and colour each of the bullet and 
text frames appropriately. Type in the bullets and text as required. Now save this page as a independent 
bitmap graphic using Export Page from the Page menu. Take the bitmap into Paintbrush/Paintshop Pro 
and cut each of the elements out and save them to disk as individual picture. 

Now replace the text in the Illuminatus frames with slideshows displaying a single bitmap version of the 
text. By setting the delay for each frame differently the bullet points can appear in any order your require. 

This can be used in both self-displaying and interactive publications.



Redo
 select Redo from the Edit menu in Page View
Ctrl+Y

Allows you to redo something you have just undone with Undo. Useful if you find you have undone too 
much.

Undo



Reference Guide
Click on one of the following topics for a comprehensive reference on that subject.

Publication View
Page View

Button Options
Page Options
Frame Options

Preview
Compile
Publish
Installation Setup
Publication Options

Preferences

Commands
Resources and Data Files



Report Text
This option on the Summary of the Button Options dialog allows you to set the button to report text to disk
or printer as set up via the Button Options: Report tab.



Reset
 select Publication Options from the Publication menu

There are circumstances where you may want your publication to automatically reset. If, for example, 
your publication is being used in public a user might leave the publication halfway through on an 
inappropriate page and you would want the publication to reset back to, say, the contents page. This 
option enables you to set that up.
You can type in a time which the publication will wait until it resets by typing it into the box labelled Reset 
After.

If you want the publication to close when it resets click on the Closedown radio button OR if you want it to 
go to a particular page in the publication click the Goto Page option and select a page from the drop down
list to the right.

You can also set a sound file to play at that time by finding the sound file you want using the Browse 
button (clicking the Audition button will let you hear the sound when you've selected one) and then 
clicking the Play Sound checkbox.

Tip: When setting the reset time interval allow plenty of time to read your most verbose page or you could
reset the publication while the user is still using it which will result in frustration and annoyance.

Closedown



Resources & Data Files
The main focus of    this version of Illuminatus is to provide a quick and easy way to bring together all the 
multimedia resources which are now available.

Illuminatus supports all major graphics formats as well as industry-standard formats for music, video and 
animations; and thereby enables you to immediately utilise all your existing resources in your multimedia 
documents.

Links with Resources
Illuminatus uses most resources directly from the original files on your hard disk. This ensures that any 
changes you make to graphics, or animations will be automatically reflected in the multimedia publication 
using them.

You can check that all the graphics, animations, sound and video files used in your publication have not 
been deleted or lost by using the Check Location option from the Data Files submenu on the File menu. 
This option gives you the chance to check and reassign the location of your resource files. 

If you edit a publication which was originally started on another drive or if the resources in your publication
are label led with a different drive you can use the Change Drive option to correct this. Suppose, for 
example, you are trying to edit a publication on your "C" drive which was originally on a CD Rom in your 
"D" drive and so expects to find all its resources on D:\. Use Change Drive to update the links with 
resource files to reflect the change of drive while retaining any directory and subdirectory information.

To help you maintain you project easily and ensure all the files you need for a publication are available to 
it Illuminatus includes an invaluable function which copies all the resource files the publication uses into 
the same directory as the editable file. This the Consolidate Project option on the Data Files submenu. 
Data Files

Text is stored by the program. If you want Illuminatus to refer to a separate disk-based text file you should
save the file to disk yourself using the Save button on Frame Options: Text.

Links with Other Programs
You can launch programs to edit your text files, graphics and sound files from within Illuminatus using the 
appropriate options on the Tools menu. The default set up uses the programs which come free with 
Illuminatus or with Windows namely, Write (for word processing), PaintShop Pro (for picture editing) and 
ILMWaved (for sound editing). You can, however, change these to suit your own particular favourites by 
using the Setup Tools option on the bottom of the Tools menu.

Remember when using word processors to create and edit text for your Illuminatus frames that you must 
save or export the file as basic DOS or ASCII text.

Text
Graphics
Sound
Moving Images



Return to Publication View
 select Return to Publication View from the File menu

Returns you to the overview of your publication from page editing mode.



Right
 select Align from the Edit menu in Page View

Selecting this option will align the righthand edge of all selected items with the righthand edge of the 
object furthest to the right.

Left
Top
Bottom
Centre Vertically
Centre Horizontally



Rolling Publications
In addition to creating interactive multimedia documents Illuminatus makes it simple to create stylish self-
displaying publications and demonstrations. Simply design the publication you require just as with any 
other multimedia publication, and then specify the length of time each page will display by type a value in 
seconds into the Timed box on the Summary of the Page Options dialog. 

This allows you to set up the intervals in tenths of a second between each page and the way in which the 
publication can be interrupted.

If you want animations, video or slideshows to appear in your self-displaying publication you need to set 
the AutoStart option for these elements (with a Delay if required). Don't forget to set the timing of the page
long enough to let the animations finish.

By combining slideshows containing just one frame you can produce most standard presentation styles.

Recreating Standard Presentation Effects



Save All Publications
Saves all the publications you currently have open to disk under their    existing filenames without further 
ado. If any are untitled a standard Save As.. dialog will appear for you to specify a location and filename.

Save Publication
Save Publication As...
Save Publication as Template
Save Compressed Publication
Save All Publications



Save As Master Page
 select Save As Master Page from the File menu

Saves the currently selected page to disk via a standard Windows file dialog as a master page.

About Master Pages



Save As... Dialog
This is a standard Save File dialog which allows you to select a location and filename for saving your 
publication.
Use the drive and directory list boxes to find the location for the file and then type a filename into the 
filename box. Saved publications are automatically given the extension .mpb. 

If this dialog appears when you have selected Save or Save All Publications it means that a publication 
was untitled.

Save Publication
Save Publication As...
Save Publication as Template
Save Compressed Publication
Save All Publications
Save Page As
Save Page As Template
Save As Master Page



Save Compressed Publication
 select Save Compressed Publication from the File menu

This option allows you to save your publication .mpb file in compressed form which will save disk space 
and is particularly recommended for large publications. You can load a compressed publication using 
Open Publication in exactly the same way as an uncompressed publication. The only difference is that 
compressed publications take longer to save and load than uncompressed ones.

You do not have to always save a publication in the format it was first saved in. We recommend that from 
time to time you save your publication while editing it and that for this you use the ordinary save. Then 
when you have finished work on the publication or are closing Illuminatus you can use Save Compressed 
Publication to save disk space.

Save Publication
Save Publication As...
Save Publication as Template
Save Compressed Publication
Save All Publications



Save Page As
 select Save Page As from the File menu

Saves the currently selected page to disk via a standard Windows file dialog to allow you to give it 
filename.



Save Page As Template
 select Save Page as Template from the File menu

This option allows you to save the design of frames and buttons on the current page to disk as a template
which can then be used in future publications via the Insert Page Template option. The page can be 
based on one of the templates supplied with the program or can be one you have created from scratch.

If you want to be able to filter your templates from all the others using the List Files of Type option the first
three letters of the filename for the template must be USR.



Save Publication
 select Save Publication from the File menu
Ctrl+S

Saves the currently selected publication to disk under its existing filename without further ado. If it is 
untitled you will be asked for a filename.

Save Publication As...
Save Publication as Template
Save Compressed Publication
Save All Publications



Save Publication As
Saves the currently selected publication to disk via a standard Windows file dialog to allow you to give it 
(new) filename.

Save Publication
Save Publication as Template
Save Compressed Publication
Save All Publications



Save Publication As Template
Enables the current publication to be saved to disk as a skeleton publication on which to base future 
projects. Only the templates for each page are saved. No text, captions or contents are saved.

This option is useful where you regularly use a consistent layout but with different content. 

Master Pages should be used where some of the content is also consistent. About Master Pages

Save Publication
Save Publication As...
Save Compressed Publication
Save All Publications



Search
This is a powerful new feature of Illuminatus which allows your user to search the publication for particular
information. You program a button to launch the search dialog for the user to select the word they are 
interested in and then select the appropriate page to view.

You can set up the Index for the search when you come to Compile or Publish your publication. 
Illuminatus automatically creates an index of the significant words and the pages they appear on in your 
publication so you do not have to set up an index manually if you don't want to and if all the words you 
want in the index are in the text of the publication itself. 

The Illuminatus Search function is contained in a .DLL which is automatically distributed with any 
publication which requires it. It therefore does not increase the size of a publication which doesn't need it.

Creating an Index for Search



Search (Button Option)
This radio button on the Button Options: Summary page tells the program to launch the search dialog to 
allow the user access to an index for the publication which you can set up via the Compile or Publish 
dialogs.

Search



Select All
 select Select All from the Edit menu
Ctrl+A

Quickly selects all the pages in a publication. 

Useful for when you want to Copy the whole of a publication ready to Paste it into another.

Related Topics
Selecting and Moving Pages



Selecting Frames and Buttons
You can select a frame or button by clicking on it. If you want to select more than one object press Shift 
while clicking. Clicking again while Shift is still pressed down will remove the item from the selection 
group. You can select multiple items by holding down the Shift key while clicking on the objects required. 
Only Delete and Align work on multiple objects.

Moving
To move the frames or buttons on a page you simply click on them and drag them to wherever you want 
them to be. You can drag multiple objects by holding down the Shift key while dragging the objects 
around.

Resizing
If you want to resize existing frames and buttons there are eight small black "handles" on the corners and 
in the middle of each side which appear when you click on the frame or button. The cursor will change to 
a set of arrows when you are over these handles. Click and drag on these to alter the size and shape of 
the element.

You can also edit the size and shape of buttons and frames by typing in the appropriate figures in the Top,
Left, Width, Height boxes on the Summary dialog.

You can delete any frame or button, together with its contents by pressing the Delete key or choosing 
Delete from the Edit menu in Page View.



Selecting and Moving Pages
Selecting pages in Illuminatus works just like multiple selection in File Manager and other Windows 
programs. 

You can select any single page by clicking on it with a single mouse click.

To select a range of pages click on the first page. Then hold down the Shift key and select the last page in
the batch. All the intervening pages will be automatically selected.

To pick a scattered selection of pages click on the first page, hold down the Ctrl key and then click on all 
the other pages you want in the batch individually.

In all the above cases to deselect a page simply click on it again. If there are multiple pages selected and 
you are pressing Ctrl only that file will be deselected.

To quickly select all the pages in a publication use Select All from the Edit menu option. There is a similar 
option to Deselect All if you need it.

You can cut, paste, delete, save and print the pages you have selected.

To reorder your pages simply select the page you want to move and drag it to where you want it placed.



Setup Tools
 select Setup Tools from the Tools menu 

This option allows you to setup your favourite word processor, paint program and sound editor to use to 
edit your multimedia resources via the Tools menu without leaving Illuminatus. 

The default settings are to use the programs which come with Windows namely; Write, Paintbrush and 
Sound Recorder. You can change them by using the appropriate Browse button to find the filename for 
the program you want to use.

So, for example, to replace Paintbrush with Corel PhotoPaint you choose Setup Tools, then click the 
Browse button alongside the Paint Program box. Search through the directories to find CORELPNT.EXE, 
select that and then press OK. Now every time you choose Picture Editor from the Tools menu Illuminatus
will launch Corel PhotoPaint.



Show Frame
This option on the Summary page of the Button Options dialog enables you to instruct a button to display 
a frame which has been set as a popup frame by checking the popup frame checkbox on the Frame 
Options: Summary dialog. Click the Show Frame checkbox and then select the frame you want by clicking
on its title in the drop down list of those available the right of the checkbox.



Size
Illuminatus now allows you to create publications to suit the three most popular display sizes... 

640x480 (VGA)
800x600 (Super VGA)
1024x768

You select which size you want when you being a new publication by clicking on the appropriate radio 
button.

Publications are always centred on screen so when publications are displayed on screen resolutions 
greater than their size they appear in the middle of the screen surrounded by the background colour of 
the page. However, when they are displayed on screen resolutions smaller than their size only the centre 
of the page will be visible.



Slideshows
Illuminatus can display a series of bitmaps in the form of a slideshow. These can be the same size or they
can be different sizes. They can simply be a presentation of related images or can be the frames of an 
animation. They can be displayed transparently in which they will appear over the background of the page
and/or over any preceding slides which give you the opportunity of building up layered graphics such as 
wiring diagrams and maps.



Sound & Music
Sound and music can make a most effective impact on your multimedia publication but you and your end 
user need a specialised sound card to enjoy the effect although you can persuade the PC speaker to play
sound effects using a special Speaker Driver program which is available from bulletin boards and 
shareware libraries if a sound card is unavailable.

However, there is no need to do two versions of a multimedia publication or to avoid music because you 
are not sure all your users will have a sound card. Your multimedia publication will not crash if it can't play
the music it will simply carry on silently.

You can stop a music file by assigning a button to play a sound without giving it a .MID file to play, i.e: by 
playing an empty sound.

Sound
Microsoft's .WAV audio format is best used for short spot effects rather than background music as it does 
not operate very well on sound files over 60 seconds long. Indeed, files are best restricted to 4 secs if 
possible as this ensures they are used in one chunk. The length of this chunk can be extended to 8 
seconds via the Setup option for the MCI Sound driver in the Drivers section of the Windows Control 
Panel but your readers will need to have it similarly setup if you are to rely on it. 
The possible consequence of an audio file too large for this buffer is that if your multimedia publication is 
doing something else at the same time (an animation, demo or similar) particularly if it is reading from the 
hard disk the sound file may stop and start.

Music
The industry-standard MIDI format is the best option for adding background music to your publication as 
Midi files can be any length and do not require the large amounts of system resources which WAV files 
can need.

You can add background music to your publication by starting the music on your first page (via the Sound 
item on the Page Options dialog) and switching off the Stop on Next Page option.

Most professional musicians are familiar with this format and compose for it and there is a good deal of 
good quality Midi music available from third-parties or public domain.
The limitation of this format is that rather than record the actual sound of an instrument it is a series of 
instructions which are sent to the digital instruments (voices) built into your sound card. Some of these 
mimic the instruments they are meant to be very well while others do not. This is particularly true of 
drums, trumpets and stringed instruments. If a piece of midi music uses instruments your sound card 
doesn't support very well the results can be appalling.

The most popular range of soundcards is the SoundBlaster series and if you are distributing your 
publication widely it will be as well to ensure it sounds best on the SoundBlaster. 

To get even better quality from the SoundBlaster Pro cards a special driver is available from the 
manufacturer which considerably improves the quality of the instrumentation under Windows.

All the midi music supplied with Illuminatus is intended for optimised for such a setup.

Graphics
Moving Images
Text



Sound Editor
This option allows you to launch your favourite sound or music editor to create or edit sound or music files
without leaving Illuminatus. When you have finished editing or creating the audio file save it to disk ready 
for use in Illuminatus. 

If you edit a file you are already using in Illuminatus the copy in your publication will be automatically 
updated

The default setting is to use the Wave Editor supplied free with Illuminatus. You can change this setting 
using the Setup Tools option on the Tools menu.

Related Topics

Sound
Setup Tools



Start AVI, MPG, FLI
Launches an Autodesk FLI or FLC animation, .MPEG movie or video file chosen by selecting its title from 
the drop down list. You must have set up a frame with a video or animation file in for the button to refer to.

Moving Images



Start Slideshow
This option launches a slideshow previously set up in a frame on the same page. You must have already 
set up the slideshow and given it a title to be able to see it in the drop down list.

Click the radio button to activate this option and then select the title for the slideshow you want to start 
from the drop down list of those available alongside.

Slideshows



Step-by-Step
Click on the procedure you want step-by-step instructions on.

Compile
Publish
Timer
Text Input



Step-by-Step Compile
Compile creates an independent version of your publication which runs outside the Illuminatus Editor. 
When you run it a dialog appears. This is what to do with each of the components of that dialog. You can 
use the Cancel button to get out of the dialog at any time.

Filename: Type in here a name for the program part of your publication e.g: mypub.exe. It can be up to 
eight characters long and cannot contain spaces. You do not have to type .exe because if you don't want 
to as Illuminatus will automatically add it if you don't. Titles and Filenames.

Directory: This is the directory where your compiled publication will be stored e.g: c:\pubs. It is NOT the 
directory where your publication will be installed by the user as this is not relevant for a compiled 
publication and this is set up via Installation Setup. If you want to create a new directory for the 
publication simply type it in here and Illuminatus will automatically create it for you. If you want to use a 
directory which already exists use the Browse Directories button to find it.

Output: Choose which colour mode you want to produce your publication in by clicking the appropriate 
radio button. If you have bought any of our publishers for other operating systems (e.g: DOS or MAC) you
will be able to output for that operating system by selecting from the drop down list on the right. About 
Colour Modes

OmniPalette: Use this option if you want Illuminatus to use an optimised palette for all your graphics and 
therefore avoid palette clash. OmniPalette is specially designed to produce acceptable results on the 
widest range of illustrations but if your illustrations are all very similar and contain mostly similar colours 
the OmniPalette option may be too much of a compromise. In this instance you can optimise the palette 
manually.

Compress Individual Pages: Use this option to compress the pages of your publication if required. The 
pages will take up less disk space when compressed but will take slightly longer to load.

Search: If you have used a button to launch a Search in your publication you will need to set up the index
this function searches and the page references it presents. You do this by clicking on the button to setup 
the keyword list. (If you haven't used Search in your publication this option will be disabled). Creating an 
Index.



And Finally: Once you have made your choices for the above options you can click on OK. This will build
an independent copy of your publication in whatever Directory you told it to. When its finished you can 
run the independent program by looking in that directory and running the program with the Filename you 
gave.

Titles and Filenames



Step-by-Step Publish
Publish creates an independent version of your publication which runs outside the Illuminatus Editor and 
then bundles all the files together, chops it up into disk-sized chunks and tops it off with a setup program 
which will install your publication onto your user's computer. 

When you run it a dialog appears. This is what to do with each of the components of that dialog. You can 
use the Cancel button to get out of the dialog at any time.

Filename: Type in here a name for the program part of your publication e.g: mypub.exe. It can be up to 
eight characters long and cannot contain spaces. You do not have to type .exe because if you don't want 
to as Illuminatus will automatically add it if you don't. Titles and Filenames.

Directory: This is the directory where your published publication will be stored e.g: c:\publish\mypub. You 
do not publish your publication directly to the floppy disks but onto your own computer from where you 
can subsequently copy it to floppy as required.. If you want to create a new directory for the publication 
simply type it in here and Illuminatus will automatically create it for you. If you want to use a directory 
which already exists use the Browse Directories button to find it.

Default Installation Directory 
Disk Size
These two items remind you of where your publication will be installed on your user's computer (unless 
they change it) and the size of disk Illuminatus will use when dividing the publication up into pieces to fit 
disk. These options are set via Installation Setup which you can access from here by clicking on the 
Setup button.

Output: Choose which colour mode you want to produce your publication in by clicking the appropriate 
radio button. For further information on which to choose read About Colour Modes    If you have bought 
any of our publishers for other operating systems (e.g: DOS or MAC) you will be able to output for that 
operating system by selecting from the Target System drop down list on the right. 

OmniPalette: Use this option if you want Illuminatus to use an optimised palette for all your graphics and 
therefore avoid palette clash. OmniPalette is specially designed to produce acceptable results on the 
widest range of illustrations but if your illustrations are all very similar and contain mostly similar colours 
the OmniPalette option may be too much of a compromise. In this instance you can optimise the palette 
manually.

Compress Individual Pages: Use this option to compress the pages of your publication if required. The 
pages will take up less disk space when compressed but will take slightly longer to load. 

Search: If you have used a button to launch a Search in your publication you will need to set up the index
this function searches and the page references it presents. You do this by clicking on the button to setup 
the keyword list. (If you haven't used Search in your publication this option will be disabled). Creating an 
Index.

And Finally: Once you have made your choices for the above options you can click on OK. This will build
an independent copy of your publication in whatever Directory you told it to. It will include all the files you 
asked to be distributed and all those specified in the Programs section of Installation Setup. It will 
combine all these files together and compress them and then create a setup.exe which runs just like the 



setup.exe which you and your user will have used to install many Windows programs and which you can 
set up via Installation Setup. 

Distributing the Publication: When Publish is complete you will find that Illuminatus has created 
subdirectories for each disk of your publication. These are called disk1, disk2, disk3 etc and are located in
whatever directory you told Illuminatus to publish into. To distribute your publication simply copy the files 
in each of these directories (not the directories themselves) to a formatted floppy first disk, second disk, 
third disk etc.

Note: Don't forget to try your publication before you distribute it.



Step-by-Step Text Input
To store information from users you need to create a text input frame and then report it to disk. You can 
also subsequently display this text in another frame.

Create A Text Input Frame
First draw the frame required in the normal way. When drawing the frame bear in mind what you will be 
asking your user to type in. The frame should be about 16 pixels deep for each line of text and wide 
enough to accommodate whatever the user is likely to want to type on one line if it is possible to predict 
that. 

You can add a frame border if you wish.

You will also want to draw another frame alongside this one to put a label or instruction for the user (e.g: 
Type Name and Address Here Please:)

Click on the Text Input check box on the Summary section of Frame Options. Type the name of the file 
you want the information saved to in the box labelled File: (e.g: c:\order.txt). You can build up a file 
containing information from a number of frames by using the Append button (text is added in the order the
frames were drawn on the page) or you can start a new file by clicking on the Overwrite option. You can 
also add a label for the piece of text by typing it into Prefix box. Thus enables you to add a database field 
identifier, a memo or a note. 

The page will now look something like this

And when the publication is run the user will be able to type information into the box. Note that the frame 
shows an icon indicating text input and showing the file the text will be saved into.



Report the Input Text to Disk
Once you have set up your text input frames you need to record this information which is done by 
instructing a button to write the text to the disk file or files you set up in the File: box (in this example 
order.txt).

Draw a button and give it the caption Save Order. Then go to the Report tab and click on the Text Input 
radio button.

Displaying the Text in Another Frame
To display this information in a frame on another page, to display a user's name for example. You should 
set the frame you want to be a scrolling text box displaying a disk-based file of the same name. Ensure 
that the frame is very large so the whole of the text, and an amount of space around it, can be displayed 
without scrollbars. 

First, create an input frame as above saving the text to a file called name.txt. You will want to set 
Overwrite on in this case to ensure that you only get a new file for each time a name is typed in.

Then go to the next page and create the frame you want to display the name in. Go to the Text dialog for 
this frame and type a character or two into the text box (the text is not important as it will be overwritten by
the input text). Use the Save button to save the file to disk under the name we used for the text input (ie: 
name.txt). Click on the Scrolling checkbox to turn the frame into a scrolling text box. In doing so you also 
set Illuminatus to load a disk-based file at this point and when run will therefore load the file into which the
user has typed their name.

However, please note that the scrolling text box function only looks for its text file in the publication's 
directory when compiled or published so when reporting or outputing text for use in this way you must 
ensure that no pathname is associated with the text so that the output function (e.g: Report Text) writes 
the text to the current directory which will be where the publication is.



Step-by-Step Timer
This shows how to use two buttons, one with a Delay option, to create a timer. In this instance the timer 
will apply to a popup frame.

Firstly draw a frame on page and type some text into it or load a picture, background colour or whatever.

Set it as a pop up frame by clicking the pop up frame checkbox. And give it an appropriate Frame Title.

Next draw a button somewhere else on your page and double click on it to go to Button Options.

Type an appropriate caption (e.g: PopUp) and then click on the Show Frame checkbox. Click on the arrow
alongside the box next to this checkbox to drop down a list of the pop up frames available on the page 
and select the Frame Title for the frame you've just created.

Now create a second button approximately the same size and shape as the first and position it over the 
other one. You can make it exactly the same size and shape if you wish but this is best done after you 
have finished editing or it can be difficult to select between the two buttons. Thus whenever the user 
clicks on one button he/she will click on both.

To avoid the potential confusion and odd appearance of two visible buttons make the second button 
invisible by checking the Invisible option on the Button Summary dialog.

Set the second button to Hide the same frame as the first one showed by clicking on the Hide Frame 
checkbox and selecting the correct page title from the drop down list alongside.

Type the number of seconds or tenths of seconds you want the pop up frame to stay visible for in the 
Delay box and click the Delay checkbox.

Run Preview to try this out. The pop up frame should appear when you click on the button and the 
automatically disappear after the time interval you set. The Cabrio Tutorial sample provided with the 
program contains working examples of this.



Stop Moving Pictures
You can instruct a button to stop any animations, video, slideshows and MPEG movies which are 
currently playing by clicking the checkbox at the bottom of the dialog on.

Button Options: Summary
Moving Images



Summary Info
Allows you to record notes and details about your publication such as title, who created it, and any notes 
or keywords you want to add. You can also assign it a category. This is for quick reminders/reference for 
when you are looking at a publication you have forgotten or which was created by someone else. 



These options provide a quick way 
to switch the other functions on and off



Technical Details
Distribution Disk Space
The distributable multimedia publication is optimised and compressed as much as possible allowing a 
viable MPB to fit on a single floppy disk. Exactly how much information will fit depends on the type of 
resources you use. Text, midi music and sixteen colour bitmaps will take up less room than WAV files and 
256 or 16.7 million colour graphics. A 1.44Mb floppy will probably hold about 20 pages of average 
material though one user of version 2.1 has fitted 90 pages on a single floppy because the style of 
graphics helped the compression. Much smaller files can be achieved by publishing your publication in 
mono (select the Mono option on the Compile or Publish dialog) although this will reduce the 
attractiveness of graphics intended for use in colour. The overhead for the executable proportion of your 
publication work is little more than 280K but there is a small additional overhead for the program which 
will install your publication from disk.

Compile Times
Compile and Publish will take slightly longer when you Compile or Publish to a colour scheme different 
from the one you are working on. This occurs because Illuminatus has additional work to do reducing the 
colours in each page. OmniPalette can also increase compile time somewhat because of the extra work 
involved.

Temporary Files
Illuminatus creates temporary files when publishing and compiling. The size of these depends on the 
number of pages in your publication. Illuminatus will warn you when you are running low on disk space 
but we suggest you keep at least 10Mb free at all times. If a compile or publish operation fails it is 
probably the reason.

Multiple Publications
You can only use graphical buttons in sub-publications (publications launched by another Illuminatus 
publication). If those publications are in the same directory as the publication which launched them.

Replaying a 256-colour publication in 16 colours
If you or your user is trying to display a 256-colour publication in 16-colour VGA mode the publication will 
run quite slowly as Illuminatus optimises each page so that it looks as good as it can under 16colours. If 
you want to avoid this you can create a special 16 colour version by selecting this in the Output section of 
the Compile and Publish dialogs.

Technical Specifications of Illuminatus Publications.
Illuminatus publications can contain up to 500 pages. Operations can become quite slow in publications 
over 150 pages and memory, processor speed and free disk space become very important with large 
publications. Large publications can be created in series if required. 

Slideshows are currently limited to 50 images except when using the All Files option which will display all 
the files in the chosen directory.

Pages are currently limited to 25 buttons and 25 frames. If you need more frames you can, where 
appropriate, add the static material and then export the page so the static material is part of the graphic 
for the background and the frames which originally contained it can be used for other things.



Technical Support
The following topics will help if you have technical problems with Illuminatus.

Frequently Asked Questions
Hints and Tips
Important Considerations
Technical Details

If you require further technical assistance with Illuminatus, call Digital Workshop Technical Support on 
01295 273476 Alternatively you can fax (01295 254590) or post details of your problem to us.

If you are a member of Compuserve you can GO WORKSHOP (Section 16 of WINPAG) where you will 
find other users to help you as well as Digital Workshop staff. You can mail us directly on [74431,1160].

If you are a member of CiX you can join theworkshop where there is a topic for Illuminatus or you can 
mail theworkshop with you question.

Save Yourself a Phone Call
To help us to maintain our technical support service free of charge please try to solve your own problems 
before you call. Things you could try first are...

Read the relevant section in the appropriate manual and look for any related subject in the index. 

Do the same with the online help

Read the Frequently Asked Questions sections of both the manual and the Help file.

Try to repeat your problem. Work through it again checking what you are doing and that you are not 
missing any steps out or moving on too quickly to notice an error message.
If you are trying to launch another program or an ILX Extension is the program in the location you have 
specified in the Launch Program: box. If you have not specified a directory make sure it is in the directory 
the publication is currently running from.
If possible try a similar thing in another Windows package. If you're having trouble printing try printing 
something from Paintbrush (for bitmap graphics) or Write (for text and/or metafile graphics). If you're 
having sound, video or animation problems try playing the file via Media Player.

Check that you are not running out of disk space (File Manager displays the free disk space in the status 
bar at the bottom) or system resources (choose Help|About in Program Manager to find out what your 
resources are). Try freeing some disk space by deleting unwanted files or restart Windows to refresh your
system resources.

When You Call
If you do need to call we will be able to help you much more if you can be at your computer with Windows
and Illuminatus running and that you have the following information to hand
The exact wording of any error message you received.
What version of our software you are running (you can find this on the About box viewed by choosing 
Help|About).
The version of Windows you are using.
The type of processor (386, 486, Pentium), the amount of RAM (memory) and disk space your computer 
has.
Graphics card type and the mode you are running in.
Make of    sound card you are using (if relevant).When you call or write to technical support, please have 
as much information as possible available including the make and type of your computer, the amount of 
memory installed and the size of hard disk. 



If it is possible to have access to your computer when phoning it is usually helpful to have the program 
running on the system when you call.



Text
Captions for buttons, titles and short pieces of text can be typed directly into Illuminatus. Larger amounts 
of text can be imported from files on disk by using the Import button on Frame Options: Text. This is to 
allow you to create your Illuminatus text using your favourite word processor and then import it into the 
publication.

If your text doesn't fit conveniently in a frame then you can set the Scrolling option to put scrollbars on the
frame (only visible in Preview or finished publications) so the user can scroll through the whole of the text 
file. This is important as large amounts of text spread across the whole page can be difficult to read.

Scrolling text boxes can now be used to display scores and information from the user. They only display 
scrollbars if required so single line text can be displayed without scrollbars. However, please note that the 
scrolling text box function only looks for its text file in the publication's directory when compiled or 
published so when reporting or outputing text for use in this way you must ensure that no pathname is 
associated with the text so that the output function (e.g: Report Text) writes the text to the current 
directory which will be where the publication is. Please also note that because of text spacing settings 
both in Illuminatus and some True Type font definitions the size of frame a single line needs before it does
not require scrollbars is considerable. 

If you want to keep a text file separate from your publication you can save it to disk using the Save button 
on the Text section of the Frame Options dialog.

Fonts
Text Formatting
Graphics
Sound
Moving Images



Text Formatting
Individual words and phrases can be highlighted by applying attributes to selected text using the buttons 
on the top right of the Text section of the Frame Options dialog. This inserts special formatting codes on 
either side of the text which Illuminatus interprets when creating the text. 

e.g: "a piece of \bbold\b text" would give..."a piece of bold text"

You can apply more than one attribute to a piece of text. 

You can edit and insert these codes manually which means they can be used in text created in a word 
processor and can be used in both scrolling text boxes and button captions.

Removing Attributes
You can remove the codes manually by selecting them and pressing the Delete key. Don't forget to 
remove the "\" and both of the pair of codes. You can also use the Remove Format button to remove all 
the codes from a particular piece of text.

Attribute Codes

\i =italic
\b =bold
\u =underline

\c =colour, followed by two numbers for each colour as follows
00 =default colour as chosen in the font selection box
01 =white
02 =light grey
03 =bright red
04 =bright yellow
05 =bright green
06 =bright cyan
07 =bright blue
08 =dark grey
09 =dark red
10 =dark yellow
11 =dark green
12 =dark cyan
13 =dark blue
14 =dark magenta
15 =light magenta
16 =black



Text Input Frame
This option on the Frame Options: Summary allows you to set your frame to accept text typed in by the 
user. No other contents are allowed in text input frames which will appear as blank white boxes. When the
mouse cursor appears over them it changes to the familiar "i" bar to show that text can be typed in. 

The frame can be any size you like but must obviously be big enough to comfortably accommodate what 
you are expecting the user to type in. The user can type in multiple lines of text if required.

You specify the file the text is to be stored in by typing the path and filename in the File box. You can tell 
Illuminatus to start a new file for this text by setting the Overwrite option or you can add the current text to 
any that exists already by checking the Append option. You can also type in a prefix for the text which will 
be recorded in the text file immediately before the text typed in by the user. This is useful for labeling the 
incoming information or tagging it with a database field name.

Step-by-step Text Input.



Timed Page
You make a page turn without requiring a button to be clicked by checking the Timed option on the 
Summary section of the Page Options dialog. This can be used to create an automatic rolling 
presentation or can be used to move a page in an interactive presentation on even if the user doesn't 
press a button.

Page Options: Summary



Titles and Filenames
To make Illuminatus easy to use it uses user-defined titles to refer to things rather than filenames. 
Whenever you select an animation, slideshow or video to go into a frame you give it a title by typing it into
the box provided. This allows a much more descriptive name than the eight letters of a DOS filename and
also allows you to use the same animation in more than one location and still know which one you are 
referring to when launching it.

When you want to add such an event to a button you can then choose the element by its title in the drop 
down list box provided.

Pages have titles too. These are shown in a box in the toolbar in Page View and can be edited there. 
They also display in Publication View as an aid to identification.

Publication Titles
Publications also have titles. A publication's title is the name which appears in the menu bar of the window
of your publication and beneath the icon in Program Manager. 

It is also used by the setup program. These are set up via the Installation Setup dialog. if you try to 
compile or publish your publication before you have set a title Illuminatus will prompt you for one as it is 
required before both Publish and Compile can proceed successfully. You will only need to set the title 
once although you can change it at any time if you wish to.

Publication Filenames
These are the names of the actual program element of your publication and should therefore be a 
standard DOS program filename such as myprog.exe or digibook.exe.



To Back
 select Move...to Back from the Edit menu

This will move a selected frame to the back to appear over behind any other frames. It will also bring a 
selected button to appear behind any other buttons.

All frames always appear behind buttons.

To Front



To Front
 select Move...to Front from the Edit menu

This will bring a selected frame to the front to appear over the top of any other frames. It will also bring a 
selected button to appear over the top of any other buttons.

To Back



Tools
This option offers you access to programs for editing text, graphics and sound without leaving Illuminatus.

The default settings are to use the programs which comes with Windows, namely Write for text, Paintshop
Pro for graphics and ILMWaved for sound. 

You can change this setting using the Setup Tools option on the Tools menu.

Related Topics
Picture Editor
Word Processor
Sound Editor
Setup Tools



Top
 select Align from the Edit menu in Page View

Selecting this option will align the top of all selected items with the top of the object highest up the page.

Left
Right
Bottom



Transparent
When displaying a bitmap graphic Illuminatus can ignore a particular colour in that image and allow 
whatever appears behind the image to show through. You can choose which colour this will be and 
usually you will want to specify the colour of the background of the image so only the object in the image 
is displayed as simulated here.

Wherever the transparency option is available the transparent colour will be displayed along with a Set 
Colour button which you can click on to bring up a standard Windows colour selection dialog to choose an
alternative. The exception to this is on the slideshow dialog. Slideshows use the transparent colour setup 
on the Background tab and you will need to edit it there if you want a different one.

Note: For technical reasons you should only pick colours which are solid in 256 colour mode and not 
those represented by a series of different coloured dots (dithered).

Tip: When creating or editing graphics to be used transparently use an unusual colour and ensure you 
pick one which isn't used in the graphic. Bright red is used for transparency in most of the images which 
come with Illuminatus, magenta is another useful colour.

Problems: There are a number of things to check if your image does not display transparently...
Ensure that the colour you have set as transparent is exactly the same as the colour you want to 

be transparent in your image as the colours may be so similar as to fool the naked eye but in fact they are
different. You can check this precisely by looking at the numerical values for Red, Green and Blue in the 
colour selection box and comparing them with those in your image when examined in a paint program.

Ensure that the area you want to be transparent is all one colour. It may be that there are 
variations in the background colour of an image (particularly photo-realistic images and where objects 
meet) which are too difficult to spot with the naked eye. You should replace the varying colour with a 
single one using something like the Flood Fill tool in Paintshop Pro with a Colour Tolerance setting high 
enough to even out all the variation in the background.

If you are running in greater than 256 colour mode and the transparency only fails when viewed in
256colours it is likely you have chosen a colour which is not solid in Windows' standard 256 colour mode. 
You will need to pick an alternative colour.



Undo
 select Undo from the Edit menu in Page View
Ctrl+Z

This allows you to undo your last change or changes. Up to 20 actions can be reversed.

Redo



Welcome Screen 
See Also Quick Start

The Welcome Screen in Illuminatus allows you to go straight to where you want to start work. You can 
click on the buttons provided to choose where you start. 

 will open a File Open dialog to let you open an existing publication or to load a sample or tutorial file.

 will open a New and entirely blank publication.

 will open a skeleton publication known as a Publication Template.

 (at the bottom of the dialog) will open the last file you used which is given in the box alongside.

If you change your mind about running Illuminatus at this time simply press the Cancel button and the 
program will close again.



What Can Illuminatus Do for Me?
At its simplest Illuminatus lets you put together interactive multimedia publications using the screen of a 
computer as the pages of an electronic book in a simple manner. It therefore allows ordinary people to 
create electronic versions of almost anything they can do on paper with greater pizzazz and with the 
advantage of being able to add sound and moving pictures too
Each page can contain a mixture of text, pictures, animations, video and sounds or music. These 
multimedia elements can be part of the page when it is first turned or can be delayed to appear later or 
can appear in response to the reader activating a button by clicking on it with the mouse or even simply 
by moving the mouse cursor over it.
When you have finished creating your publication you make a fully-independent program simply by 
"compiling" it this creates a ready-to-run copy for you to run outside the Illuminatus editor on your own 
computer, or "publishing" it    which creates an installable version of the publication and chops it up into 
chunks the right size for distributing on disk.
The process is much like creating a booklet with a desktop publishing package except the final result is an
interactive multimedia document on disk or CD-Rom rather than printed on paper, hence multimedia 
publishing.

Illuminatus - mirabile dictu, mirabile visu

Learning About Illuminatus
What is Multimedia Publishing



What Colour Mode Should I Choose?
Mono
Black & white. Use this mode for creating very small distributable files. Some stylish effects can still be 
produced in black and white. 
16 colours
The "Windows" colours which are the solid colours available in Paintbrush. This mode offers simple colour
with relatively small files and so is useful for creating boldly coloured but small publications, e.g: for 
children’s programs which need to be distributed on disk. 
Not recommended for photo quality material but if you absolutely have to display photographs in 
16colours use a good paint package to reduce them to 16colours using a dithering method called Error 
Diffusion.
Not suitable for animations and not really recommended for video.
256 colours
This mode provides the smallest/quickest publications which can contain reasonable quality photographic 
material, video and animation. The snag is that any one picture, video or animation can take up all the 
256colours available to look its best so if another appears on the same page it has to use the colours in 
the first picture which can make it look very poor. This is called palette clash and is dealt with in further 
detail later on.
64k and 16.7million colours 
These colour modes offer even greater photorealism than 256colours without palette clashing. The cost is
that publishing in these colour modes will produce extremely large files. This is only recommended for 
publications which will be distributed on CD-Rom, where quality is paramount and/or where palette 
clashes are too awkward to resolve



What is Multimedia Publishing?
Multimedia is one of the most exciting forms of communication available to us today but until now creating
multimedia communications was a difficult and demanding job. Now Illuminatus introduces multimedia 
publishing which extends the concept of desktop publishing into the audio-visual, interactive realm of 
multimedia. With Illuminatus interactive multimedia programs can be created as easily as a DTP 
document and published in digital form for distribution on floppy disk, CD Rom or across the Internet. 

Multimedia is already a favourite tool for the business presentation professional. Illuminatus offers the 
ability to quickly and easily add multimedia pizzazz to standard business presentation and promotional 
items but also allows you to extend presentation and promotion into new modes by easily adding 
interactivity and distribution of the finished publication.
Illuminatus is so simple to use that you don't need to be an expert to use it. Thus you can be an expert in 
something else and yet develop an interactive multimedia application.    It provides an ideal opportunity for
enthusiasts and specialists to pass on their knowledge in this most exciting and effective way. It is also 
particularly useful where confidentiality is an issue and where the involvement of as few additional parties 
as possible is required. 

Furthermore, you can also tailor your project to your own needs, capacities and budget so interactive 
multimedia comes into the reach of small businesses and    even individuals. 

Multimedia Publishing offers "books" which can include sounds, and moving images as well as words and
pictures, and which can be interactive. That is, they do not have to read page by page but allow the 
reader to choose the course of their study.

Multimedia publishing also offers the creative person an opportunity for creativity beyond what was 
previously available. A single creative artist can command words, pictures, music, sound and filmic 
images into whatever combination he or she desires.

As implemented by Illuminatus multimedia publishing works in much the same way as DTP except that 
the documents it publishes are published in computer form rather than on paper. Illuminatus makes 
multimedia publishing easy and will publish onto floppy disks so that it makes it possible to produce 
multimedia versions of even simple documents such as memos and greeting cards.

Multimedia publishing is extraordinary communication for ordinary people. Illuminatus is multimedia 
publishing at its easiest.

Illuminatus - mirable dictu, mirable visu



Window Menu Option
Cascade
Arranges all the windows you currently have open neatly into a stepped array with the title bars showing.

Tile
Arranges all the window you currently have open neatly in a tiled arrangement. 

Arrange Icons
Neatly arranges and spaces the icons of minimised publications at the bottom of the main window.

Close All 
Closes all the windows you currently have open, including minimised ones, asking you if you want to save
those which have changed



Word Processor
This option allows you to launch your favourite text editor or word processor program to create or edit text
without leaving Illuminatus. When you have finished editing or creating the text save it to disk ready for 
use in Illuminatus. 

You must save it as DOS or ASCII text to use it in the current version of Illuminatus. 

If you edit a file you are already using in Illuminatus the copy in your publication will be automatically 
updated

Related Topics
Text
Setup Tools



Working with More Than One Object
You can select more than one object at a time by pressing the Shift key at the same time as clicking on 
the object. The selection handles will appear around each one. You can select a both buttons and frames 
or a mixture.

Having selected multiple objects you can move them by keeping Shift pressed down and dragging one of 
the objects to the new location.

You can delete all the selected objects by pressing the Delete key or toolbar button just as you would with
single objects.

You can resize multiple objects by resizing one of the objects in a multiple selection. The others will be 
resized similarly.



Zoom 100%
 select Zoom 100% from the Page menu

Shows your current page at the size it will actually display. This gives you the best preview of your page 
without using Preview but unless you are running Illuminatus in a resolution higher than 640x480 you will 
not be able to see the whole page at once. 

Related Topics
Zoom 50%
Zoom To Fit
Next Page
Previous Page
First Page
Last Page
Preview



Zoom 50%
 select Zoom 50% from the Page menu

Shows your current page at half the size it will display. This view is often a good compromise for users 
running Illuminatus in 640x480 allowing you to see the whole page in reasonable detail.

Related Topics
Zoom 100%
Zoom To Fit
Next Page
Previous Page
First Page
Last Page
Preview



Zoom to Fit
 select Zoom to Fit from the Page menu

Scales the view of the current page so that the whole page fits into the current window. When you resize 
the window the page will be scaled to fit the new size. If you zoom to fit when the window is quite small 
you may lose some details of your page and it may be difficult to select the elements you want to edit. We
recommend you use Zoom to Fit with the largest possible window - maximise both Illuminatus and your 
publication window. 

Related Topics
Zoom 50%
Zoom 100%
Next Page
Previous Page
First Page
Last Page
Preview



Custom Cursors
You do not need only use the default Windows cursors in your publication but can instead use ones    
related to the subject of your publication. 

There are three states you can set cursors for
Normal 
This is the cursor which will simply indicate the position of the mouse pointer when the others are not 
used.
Busy 
This is used when the system is doing something and is usually the familiar egg timer cursor.
Select
This cursor is used when there is something to be clicked on. 

You set up custom cursors via the Publication Options: Cursors dialog.

Ordinarily under Windows both Select and Normal are the same arrow shape but they are separated here
to allow you to have special cursors to signify when there is a hotspot or hidden button on the page so 
users do not miss buttons which do not look like buttons.

A range of both unusual and basic cursors are provided with the program.






